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BAB I 

PENDAHULUAN 

1.1 Pengantar 

Keamanan rumah adalah salah satu aspek terpenting 

dalam kehidupan sehari hari. Dengan banyaknya angka 

kejahatan terutama pencurian, kebutuhan akan system 

keamanan yang efektif semakin mendesak. Menurut data 

terbaru, banyak rumah yang menjadi target pencurian karena 

kurangnya pengawasan dan sitem keamanan yang memadai. 

Oleh karena itu, pengembangan sistem keamanan yang dapat 

memberikan notifikasi secara real-time kepada pemilik rumah 

menjadi solusi yang sangat diperlukan. 

Sistem kendali keamanan pintu pagar berbasis kamera 

ESP32-CAM dengan notifikasi Telegram menawarkan 

pendekatan inovatif dalam meningkatkan keamanan rumah. 

Dengan memanfaatkan teknologi Internet of Things (IoT), 

sistem ini tidak hanya dapat mendeteksi gerakan tetapi juga 

memberikan informasi visual kepada pemilik rumah melalui 

gambar yang diambil oleh kamera. Notifikasi yang dikirimkan 

melalui aplikasi Telegram memungkinkan pengguna untuk 

mengawasi keadaan rumah mereka dari jarak jauh, sehingga 

meningkatkan rasa aman dan nyaman. 

1.2 Internet of Things 

Internet of Things (IoT) adalah konsep di mana berbagai 

perangkat fisik dapat saling terhubung melalui internet, 

memungkinkan mereka untuk berbagi data dan berinteraksi 

satu sama lain secara otomatis. Perangkat ini mencakup segala 



 

2 

 

sesuatu, mulai dari smartphone, kamera CCTV, lampu pintar, 

hingga mesin di pabrik. 

Komponen Utama IoT: 

1. Perangkat IoT ialah Perangkat pintar yang dilengkapi dengan 

sensor, aktuator, atau alat lain untuk mengumpulkan data atau 

melakukan tugas tertentu. Contohnya adalah smartwatch atau 

termostat pintar. 

2. Koneksi dalam IoT mengandalkan konektivitas, seperti Wi-

Fi, Bluetooth, 5G, atau jaringan lainnya, untuk 

menghubungkan perangkat ke internet. 

3. Platform IoT. Data yang dikumpulkan perangkat IoT dikirim 

ke platform yang digunakan untuk menyimpan, menganalisis, 

dan mengambil tindakan berdasarkan data tersebut. 

4. Data dan Analitik IoT menghasilkan data dalam jumlah 

besar, yang dapat diolah untuk memberikan wawasan baru 

atau menjalankan tindakan otomatis(Bangun1 et al., 2020). 

Contoh Penerapan IoT: 

1. Rumah Pintar: Lampu, kunci pintu, dan AC yang bisa 

dikendalikan melalui smartphone. 

2. Kesehatan: Wearable devices seperti smartwatch yang 

memonitor detak jantung atau aktivitas fisik. 

3. Industri: Mesin di pabrik yang saling terhubung untuk 

meningkatkan efisiensi produksi. 

4. Kota Pintar dalam Lampu jalan yang otomatis menyala saat 

gelap atau tempat parkir yang memberi tahu ketersediaan 

melalui aplikasi. 
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Kelebihan IoT: 

1. Meningkatkan efisiensi dan produktivitas. 

2. Memberikan kenyamanan dan kemudahan. 

3. Memungkinkan pengambilan keputusan yang lebih cepat dan 

berdasarkan data. 

Tantangan IoT: 

1. Keamanan: Risiko perangkat diretas. 

2. Privasi: Data pengguna harus dikelola dengan bijak. 

3. Kompleksitas: Banyak perangkat memerlukan pengaturan 

dan kompatibilitas yang baik. 

4. IoT sedang berkembang pesat dan menjadi bagian dari 

kehidupan sehari-hari, membuka peluang baru di berbagai 

bidang, mulai dari bisnis hingga kehidupan pribadi. 

1.3 Penggunaan teknologi 

Penggunaan teknologi mengacu pada cara manusia 

memanfaatkan berbagai alat, sistem, metode, dan pengetahuan 

untuk memecahkan masalah, meningkatkan efisiensi kerja, 

dan menciptakan kenyamanan serta kemudahan dalam 

kehidupan sehari-hari. Teknologi hadir sebagai hasil dari 

perkembangan ilmu pengetahuan yang terus berkembang 

untuk memenuhi kebutuhan manusia yang semakin kompleks. 

Dalam penggunaannya, teknologi tidak hanya terbatas pada 

alat sederhana seperti roda yang menjadi salah satu penemuan 

penting dalam sejarah peradaban manusia, tetapi juga 

mencakup sistem canggih yang saat ini menjadi tulang 

punggung dunia modern, seperti kecerdasan buatan (AI), 

blockchain, serta Internet of Things (IoT)(Wijaya Setiady & 

Amanda Ginting, 2023). 
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Kemajuan teknologi telah membawa perubahan besar 

dalam berbagai aspek kehidupan, mulai dari cara manusia 

berkomunikasi, bekerja, belajar, hingga bagaimana mereka 

mengelola sumber daya alam dan lingkungan. Teknologi 

sederhana yang ditemukan di masa lalu, seperti alat-alat 

pertanian, telah berevolusi menjadi mesin-mesin otomatis 

yang mampu meningkatkan produktivitas secara signifikan. 

Di sisi lain, teknologi modern seperti AI dan blockchain kini 

membuka peluang baru dalam bidang yang lebih kompleks, 

seperti otomatisasi, keamanan digital, dan analisis data 

berskala besar. Dengan kata lain, teknologi merupakan bagian 

integral dari kehidupan manusia yang terus berkembang untuk 

menjawab tantangan zaman, sekaligus menciptakan peluang 

untuk masa depan yang lebih baik. 

 

Penggunaan Teknologi di Berbagai Bidang: 

1. Keseharian 

a) Gadget Pribadi: Smartphone, tablet, dan smartwatch 

membantu komunikasi, hiburan, dan manajemen waktu. 

b) Rumah Pintar: Teknologi seperti lampu otomatis, asisten 

virtual (seperti Alexa atau Google Assistant), dan 

perangkat keamanan meningkatkan kenyamanan dan 

keamanan rumah. 

 

2. Edukasi 

a) E-learning: Platform seperti Google Classroom atau 

Zoom memungkinkan pembelajaran jarak jauh. 

b) Alat Pembelajaran Digital: Smartboards dan aplikasi 

pendidikan membantu siswa belajar secara interaktif. 
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3. Kesehatan 

a) Peralatan Medis: MRI, CT Scan, atau teknologi robotik 

dalam operasi. 

b) Telemedicine: Konsultasi dokter secara daring. 

c) Wearables: Alat seperti Fitbit memonitor kesehatan 

secara real-time. 

 

4. Bisnis 

a) Otomasi: Robot dan AI meningkatkan produktivitas di 

pabrik. 

b) Digital Marketing: Teknologi seperti SEO, media sosial, 

dan iklan online membantu bisnis menjangkau 

konsumen. 

c) E-commerce: Toko online memudahkan transaksi kapan 

saja dan di mana saja. 

 

5. Transportasi 

a) Kendaraan Otonom: Mobil tanpa pengemudi yang 

didukung oleh AI. 

b) Aplikasi Navigasi: GPS seperti Google Maps 

memberikan informasi rute dan kondisi lalu lintas secara 

real-time. 

c) Ride-Sharing: Teknologi memungkinkan layanan 

transportasi seperti Grab atau Gojek. 

 

6. Keamanan 

a) Sistem Pengawasan: CCTV pintar dengan kemampuan 

pengenalan wajah. 

b) Keamanan Siber: Enkripsi dan firewall melindungi data 

dari ancaman dunia maya. 
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7. Lingkungan dan Energi 

a) Energi Terbarukan: Teknologi panel surya atau turbin 

angin membantu pengurangan emisi karbon. 

b) Pemantauan Lingkungan: Sensor IoT untuk memonitor 

kualitas udara atau air. 

Manfaat Utama Penggunaan Teknologi: 

a) Efisiensi: Menghemat waktu dan tenaga. 

b) Kemudahan: Mempermudah akses informasi dan 

komunikasi. 

c) Inovasi: Membuka peluang baru untuk menciptakan 

solusi yang lebih baik. 

Tantangan dalam Penggunaan Teknologi: 

a) Ketergantungan: Terlalu bergantung pada teknologi dapat 

mengurangi keterampilan manual. 

b) Keamanan: Risiko privasi dan ancaman siber. 

c) Kesenjangan Digital: Tidak semua orang memiliki akses 

yang setara terhadap teknologi. 

Secara keseluruhan, teknologi adalah alat yang sangat 

bermanfaat jika digunakan dengan bijak, menciptakan 

peluang untuk hidup lebih baik dan produktif(Purnama et al., 

2020). 

1.4 Manfaat sistem kendali berbasis IoT 

Sistem kendali berbasis IoT (Internet of Things) 

menawarkan banyak manfaat, terutama karena 

kemampuannya untuk menghubungkan perangkat fisik dan 

mengelola data secara otomatis melalui internet. Berikut 

beberapa manfaat utama dari sistem ini: 
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1. Efisiensi Operasional 

IoT memungkinkan pengendalian perangkat secara otomatis 

berdasarkan data real-time, sehingga proses kerja menjadi 

lebih efisien. Misalnya, dalam sistem manufaktur, IoT dapat 

mengoptimalkan penggunaan mesin, mendeteksi kerusakan 

lebih awal, dan meminimalkan waktu henti (downtime). 

1. Pemantauan Jarak Jauh 

Sistem kendali berbasis IoT memungkinkan pengawasan 

dan pengendalian perangkat dari mana saja menggunakan 

aplikasi atau dashboard berbasis cloud. Contohnya, 

pengelolaan rumah pintar (smart home) memungkinkan 

pengguna mengontrol pencahayaan, suhu ruangan, atau 

perangkat elektronik hanya melalui smartphone, 

meskipun berada jauh dari rumah. 

 

2. Hemat Energi dan Biaya 

IoT dapat digunakan untuk mengelola konsumsi energi 

dengan cerdas. Misalnya, sistem IoT pada gedung 

perkantoran dapat mengatur penggunaan listrik, seperti 

mematikan lampu atau pendingin ruangan di ruangan 

yang tidak digunakan. Hal ini membantu mengurangi 

pemborosan energi dan menekan biaya 

operasional(Faisal, 2021). 

 

3. Analisis Data yang Lebih Baik 

IoT mengumpulkan data dari berbagai perangkat yang 

terhubung. Data ini dapat dianalisis untuk memahami pola 

penggunaan, mendeteksi anomali, dan membuat prediksi, 

seperti memprediksi kebutuhan perawatan mesin di 

industri atau mendeteksi potensi kegagalan perangkat 

sebelum terjadi. 
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4. Meningkatkan Keamanan 

Sistem kendali berbasis IoT memungkinkan pemantauan 

keamanan yang lebih canggih, seperti kamera CCTV 

pintar dengan fitur pengenalan wajah atau sistem alarm 

otomatis yang terintegrasi dengan sensor gerak. Ini 

membantu mencegah ancaman dan meningkatkan respons 

terhadap insiden. 

 

5. Automasi dan Kemudahan 

IoT memungkinkan automasi dalam berbagai aspek, 

seperti sistem irigasi pintar yang hanya mengairi tanaman 

saat kelembapan tanah rendah, atau lampu jalan yang 

menyala otomatis berdasarkan intensitas cahaya. 

Automasi ini mempermudah pekerjaan manusia dan 

mengurangi kebutuhan intervensi manual. 

 

6. Fleksibilitas dan Skalabilitas 

Sistem berbasis IoT mudah diperluas atau disesuaikan 

sesuai kebutuhan. Pengguna dapat menambahkan 

perangkat baru ke sistem tanpa perlu mendesain ulang 

seluruh infrastruktur, menjadikannya pilihan yang sangat 

fleksibel untuk berbagai skala penggunaan, baik di rumah, 

bisnis, maupun industri besar. 

 

7. Meningkatkan Pengalaman Pengguna 

Dalam aplikasi konsumen, seperti wearable devices atau 

smart gadgets, IoT memberikan pengalaman pengguna 

yang lebih personal dan responsif. Misalnya, smartwatch 

dapat memberikan rekomendasi kesehatan berdasarkan 

pola aktivitas harian pemakainya. 
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8. Mendukung Inovasi dan Transformasi Digital 

Dengan memanfaatkan teknologi IoT, perusahaan dapat 

menciptakan model bisnis baru, seperti layanan berbasis 

data, dan mempermudah transformasi digital di berbagai 

sektor. 

Dengan semua manfaat ini, sistem kendali berbasis IoT menjadi 

salah satu pilar penting dalam mewujudkan kehidupan yang lebih 

cerdas, hemat, dan terintegrasi. 
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BAB II 

KOMPONEN DAN ALAT YANG DIGUNAKAN 

2.1 Daftar Komponen utama 

Komponen utama yang akan digunakan untuk membangun 

sistem ini adalah: 

a) ESP32-CAM 

Modul ini memiliki ukuran yang relatif kecil dan sering 

digunakan dalam proyek-proyek elektronik untuk 

memfasilitasi konektivitas Wi-Fi dan Bluetooth. Ia 

memiliki port untuk menghubungkan kamera serta 

input/output digital yang memungkinkan interaksi dengan 

perangkat lain. 

 

b) Adaptor ESP32-CAM 

Adaptor ini biasanya digunakan untuk menyambungkan 

ESP32-CAM ke komputer untuk pemrograman. 

Bentuknya sederhana dengan port USB di satu ujung dan 

konektor untuk ESP32-CAM di ujung lainnya(Ipanhar et 

al., 2022). Ini memudahkan pengisian daya dan 

pemrograman tanpa menggunakan kabel tambahan. 

 

c) Solenoid Door Lock.  

Komponen ini berbentuk silinder kecil yang terbuat dari 

logam. Biasanya digunakan dalam proyek-proyek 

keamanan elektronik, solenoid door lock dapat terkunci 

atau terbuka dengan memberikan sinyal elektrik. Ia 

memanfaatkan medan magnet untuk mengontrol 

mekanisme buka/tutup pintu. 
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d) Breadboard 400.  

Breadboard 400 memiliki ukuran yang kompak dan 

dilengkapi dengan banyak titik sambungan untuk 

memudahkan perakitan rangkaian elektronik sementara. 

Ia tidak memerlukan soldering untuk menyambungkan 

kabel atau komponen, menjadikannya ideal untuk 

pengujian dan pemrograman awal. 

 

e) Relay Module 1-Channel 

Modul relay ini dirancang dengan memisahkan bagian 

input dan output untuk memudahkan integrasi dengan 

perangkat mikrokontroler seperti ESP32-CAM. Memiliki 

satu saluran untuk mengontrol daya listrik yang lebih 

besar, sehingga dapat mengaktifkan perangkat seperti 

motor atau solenoid door lock. 

 

f) Buzzer 

Buzzer ini berfungsi untuk menghasilkan suara ketika 

sebuah peringatan atau status tertentu terjadi dalam 

sistem. Ukurannya kecil dan dapat menghasilkan suatu 

nada yang berbeda, memungkinkannya untuk digunakan 

dalam berbagai proyek elektronik untuk memberi tahu 

pengguna atau sebagai indikator. 

 

g) LED RGB.  

LED RGB adalah satu dioda yang mampu menghasilkan 

kombinasi warna merah, hijau, dan biru. Ia sering 

digunakan sebagai indikator visual untuk menunjukkan 

status atau kondisi sistem. LED ini fleksibel dalam 

penggunaannya karena kemampuannya untuk 

memproduksi berbagai warna. 
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h) Resistor 

Resistor adalah komponen pasif yang digunakan untuk 

membatasi aliran arus dalam rangkaian elektronik. 

Bentuknya sederhana, biasanya berbentuk silinder kecil 

dengan dua kaki. Meskipun tanpa fitur khusus, resistor 

memainkan peran penting dalam melindungi komponen 

lain dari arus berlebih. 

 

i) Kabel Micro USB.  

Kabel ini sering digunakan untuk menghubungkan 

perangkat elektronik dengan port USB ke komputer atau 

sumber daya listrik. Ukurannya kecil dan fleksibel, 

memungkinkan koneksi yang stabil antara ESP32-CAM 

dan komputer untuk pemrograman atau pengisian daya. 

 

j) Kabel Konektor (Jumper Cable) 

Kabel konektor ini terdiri dari dua ujung yang dilengkapi 

dengan konektor. Mereka digunakan untuk membuat 

sambungan sementara antara titik-titik di breadboard atau 

menghubungkan modul-modul tanpa memerlukan 

soldering. Jumper cable sangat berguna untuk 

menghubungkan ESP32-CAM dengan berbagai 

komponen dalam sistem. 
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2.2 Spesifikasi dan Fungsi Komponen 

a) ESP32-CAM 

Mikroprosesor dengan Wi-

Fi dan Bluetooth bawaan 

yang mendukung kamera 

OV2640 berfungsi sebagai 

pengendali utama untuk 

berbagai aplikasi. 

Dilengkapi dengan 

kemampuan untuk menangkap gambar berkualitas tinggi 

melalui kamera OV2640, mikroprosesor ini memungkinkan 

pengumpulan data visual yang detail dan akurat. Selain itu, 

dengan adanya dukungan Wi-Fi dan Bluetooth, mikroprosesor 

ini dapat dengan mudah terhubung ke berbagai perangkat lain 

dan jaringan nirkabel, memungkinkan komunikasi yang 

efisien dan pengendalian jarak jauh(Atmaja et al., 2024). 

Mikroprosesor ini juga mampu mengirimkan notifikasi 

melalui internet, memberikan kemampuan untuk 

memperingatkan pengguna tentang berbagai kejadian atau 

status perangkat secara langsung, menjadikannya pilihan yang 

ideal untuk aplikasi seperti smart home, pengawasan 

keamanan, atau sistem otomatisasi industri. Fungsionalitas ini 

memungkinkan mikroprosesor untuk berfungsi sebagai pusat 

kendali utama yang menangkap gambar, mengontrol 

perangkat lain, serta mengirimkan informasi penting ke 

perangkat pengguna dengan cepat dan tepat. 

b) Adaptor ESP32-CAM 

 Board kecil yang mempermudah koneksi ESP32-

CAM ke komputer melalui konektor micro USB 

gambar 2.1 ESP32-CAM 
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dirancang untuk mempermudah pemrograman perangkat 

ini. Dengan menggunakan konektor micro USB, board ini 

menyediakan cara yang sederhana dan stabil untuk 

menghubungkan ESP32-CAM ke komputer, 

memungkinkan transfer data dan pengisian daya yang 

lancar.  

 Selain itu, board ini juga berfungsi sebagai alat 

pemrograman, memberikan akses langsung ke port UART 

untuk memuat dan mengunggah kode, serta 

memungkinkan debug secara real-time. Keuntungan dari 

desain ini adalah kemampuan untuk melakukan 

pemrograman perangkat secara efisien tanpa perlu 

penggunaan adaptor atau kabel tambahan. Dengan 

menyediakan koneksi daya yang stabil dan kemampuan 

untuk memuat dan menjalankan kode secara cepat, board 

kecil ini sangat cocok digunakan dalam proyek-proyek 

berbasis ESP32-CAM, termasuk pengembangan aplikasi 

smart home, sistem pengawasan kamera, atau proyek IoT 

lainnya yang memerlukan fitur-fitur komunikasi nirkabel 

dan pemrosesan data berbasis gambar(Jardian & Owen, 

2024). 

 

c) Solenoid Door Lock 

Mekanisme kunci berbasis 

solenoid yang bekerja pada 

tegangan DC tertentu, biasanya 

12V, dirancang untuk 

menyediakan kontrol mekanis 

pada pintu pagar. Solenoid ini 

menggunakan arus listrik DC 

untuk menghasilkan medan  

gambar 2.2 Solenoid door 

lock 
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 magnet yang memungkinkan kunci untuk terkunci 

atau terbuka. Ketika perintah diberikan dari relay, 

solenoid akan menerima sinyal untuk membuka atau 

mengunci pintu pagar, memberikan keamanan tambahan 

dengan cara yang praktis dan otomatis.  

 Keunggulan dari solenoid berbasis tegangan DC 

adalah kemampuannya untuk bekerja dengan efisiensi dan 

daya tahan yang baik pada tegangan yang umum 

digunakan, seperti 12V. Penggunaan solenoid ini 

memungkinkan pengoperasian yang mudah dan dapat 

diandalkan dalam sistem keamanan berbasis otomatisasi, 

seperti akses kontrol pada rumah, kantor, atau fasilitas 

komersial, di mana keamanan dan kenyamanan 

pengendalian pintu sangat penting 

d) Breadboard 400 

Breadboard kecil dengan 

400 titik koneksi adalah 

alat yang sangat berguna 

dalam merakit rangkaian 

elektronik sementara 

tanpa memerlukan 

soldering(Sistem & Tgd, 

2022). Dengan 

desainnya yang praktis, 

breadboard ini memungkinkan pengguna untuk menyusun 

dan menguji komponen-komponen seperti resistor, 

kapasitor, transistor, dan IC secara sementara dan 

modular. 

gambar 2.3  BreadBoard 
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 Setiap titik koneksi pada breadboard kecil ini 

terhubung secara horizontal dan vertikal, memudahkan 

penyusunan kabel jumper untuk membangun rangkaian tanpa 

memerlukan    peralatan    soldering   atau membuang-buang  

waktu dalam menyolder komponen satu per satu. Hal ini 

membuat breadboard kecil ini ideal digunakan dalam proyek-

proyek eksperimen, pengembangan prototipe, atau 

pembelajaran elektronik, di mana fleksibilitas dan 

kemampuan untuk mengubah dan menyesuaikan rangkaian 

dengan cepat sangat penting. Dengan 400 titik koneksi, 

breadboard ini memberikan ruang yang cukup luas untuk 

merakit berbagai jenis rangkaian dan memungkinkan 

pengujian desain secara langsung sebelum dipindahkan ke 

papan solder permanen. 

e) Modul relay 1 ch 

Modul relay yang 

mampu menangani 

beban daya hingga 10A 

dirancang untuk 

memberikan kontrol 

yang andal terhadap 

perangkat listrik, 

seperti solenoid door 

lock. Dengan kapasitas arus yang besar, modul ini dapat 

menghubungkan atau memutus aliran listrik dengan aman dan 

efisien, sehingga memungkinkan pengoperasian perangkat 

secara otomatis berdasarkan sinyal kontrol(Yusuf et al., 

2024). Dalam aplikasi seperti sistem akses pintu, relay ini 

berfungsi sebagai penghubung utama antara pengontrol 

gambar 2.4  Modul relay 1 channel 
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elektronik dan solenoid, memastikan arus listrik hanya 

mengalir saat diperlukan untuk membuka atau mengunci 

pintu.  

 Dengan kemampuan untuk menangani beban hingga 

10A, modul ini tidak hanya cocok untuk solenoid door lock, 

tetapi juga untuk berbagai perangkat listrik lainnya yang 

membutuhkan kontrol yang presisi dan dapat diandalkan, 

menjadikannya komponen penting dalam sistem otomatisasi 

rumah atau proyek berbasis IoT. 

 

f) Buzzer 

 Buzzer aktif yang dapat bekerja 

pada tegangan 3.3V–5V 

dirancang untuk memberikan 

peringatan suara yang efektif dan 

mudah diintegrasikan ke dalam 

berbagai sistem elektronik. 

 Dengan rentang tegangan 

operasional yang fleksibel, buzzer 

ini kompatibel dengan banyak jenis mikrokontroler dan 

rangkaian elektronik standar, membuatnya ideal untuk 

aplikasi yang membutuhkan notifikasi audio. Buzzer aktif ini 

dapat menghasilkan bunyi tanpa memerlukan sirkuit 

tambahan untuk mengontrol frekuensinya, sehingga 

mempermudah penggunaannya dalam berbagai proyek. 

Fungsi utamanya adalah memberikan peringatan suara untuk 

menandai notifikasi atau status tertentu, seperti alarm, indikasi 

kesalahan, atau konfirmasi operasi berhasil. Keunggulan ini 

menjadikan buzzer aktif sebagai pilihan populer dalam sistem 

keamanan, perangkat IoT, aplikasi smart home, dan berbagai 

gambar 2.5 Buzzer 
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proyek elektronik lainnya, di mana notifikasi suara diperlukan 

untuk memberikan informasi atau respons instan kepada 

pengguna(Santoso et al., 2024). 

g) LED RGB 

LED RGB yang mampu 

menampilkan berbagai warna 

berdasarkan kombinasi merah, 

hijau, dan biru adalah 

komponen serbaguna yang 

sering digunakan sebagai 

indikator visual dalam sistem 

elektronik. Dengan 

kemampuan menghasilkan 

berbagai warna hanya dengan mengatur intensitas ketiga 

warna dasar tersebut, LED ini dapat menyampaikan informasi 

status secara intuitif. 

Fungsinya meliputi indikasi koneksi sistem, seperti warna 

hijau untuk menandakan koneksi berhasil, merah untuk 

menunjukkan kesalahan, atau biru untuk menunjukkan deteksi 

aktivitas. Fleksibilitas dalam pengaturan warna 

memungkinkan LED RGB untuk digunakan dalam berbagai 

aplikasi, termasuk perangkat IoT, sistem keamanan, dan 

proyek smart home, di mana visualisasi status yang jelas dan 

informatif sangat dibutuhkan. Selain itu, konsumsi daya yang 

rendah dan kemampuan untuk diintegrasikan dengan 

mikrokontroler menjadikan LED RGB komponen yang andal 

dan efisien untuk memberikan feedback langsung kepada 

pengguna(Hazra et al., 2024). 

gambar 2.6 LED RGB 
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h) Resistor 

Resistor adalah komponen pasif 

dengan nilai hambatan tertentu, 

biasanya dalam rentang 220Ω 

hingga 10kΩ, yang berfungsi untuk 

membatasi arus listrik dalam 

rangkaian elektronik. Dengan 

kemampuannya untuk mengontrol 

aliran arus, resistor melindungi komponen lain, seperti LED 

RGB, dari kerusakan akibat arus yang berlebihan. Sebagai 

contoh, dalam penggunaan LED RGB, resistor ditempatkan 

secara seri untuk memastikan bahwa arus yang mengalir ke 

setiap warna LED berada dalam batas aman, sehingga 

mencegah overheat atau kerusakan permanen.  

Nilai hambatan resistor dipilih berdasarkan kebutuhan 

spesifik rangkaian untuk menjaga keseimbangan antara 

perlindungan komponen dan kinerja optimal. Resistor juga 

digunakan dalam berbagai aplikasi lainnya, seperti pembagi 

tegangan, filter sinyal, atau pengaturan waktu dalam sirkuit 

RC. Sebagai elemen penting dalam desain rangkaian 

elektronik, resistor membantu menjaga stabilitas, keandalan, 

dan efisiensi sistem, menjadikannya salah satu komponen 

dasar yang tidak tergantikan dalam berbagai proyek elektronik 

dan otomasi. 

i) Konektor Micro USB 

Kabel dengan konektor micro USB di salah satu ujungnya 

merupakan komponen penting dalam pengoperasian 

perangkat seperti adaptor ESP32-CAM. Kabel ini dirancang 

untuk menyediakan koneksi yang andal antara ESP32-CAM 

gambar 2.7 Resistor 
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dan komputer atau sumber daya 

eksternal, memungkinkan pengisian 

daya sekaligus transfer data secara 

efisien. Konektor micro USB di 

ujungnya memastikan 

kompatibilitas yang luas dengan 

berbagai perangkat modern, 

sementara panjang dan fleksibilitas 

kabel memungkinkan penggunaan 

yang praktis dalam berbagai situasi. 

Dalam konteks ESP32-CAM, kabel ini digunakan untuk 

menghubungkan adaptor agar dapat memprogram perangkat, 

mengunggah kode, atau memberikan daya stabil selama 

operasi. Dengan kemampuan untuk menangani transfer data 

cepat dan pengisian daya yang konsisten, kabel ini menjadi 

komponen yang sangat penting dalam pengembangan proyek 

berbasis IoT, pengujian prototipe, dan aplikasi lainnya yang 

membutuhkan konektivitas USB yang handal. 

j) Kabel Jumper 

 Kabel jumper dengan 

konektor di ujungnya, baik 

male-to-male, female-to-

female, maupun kombinasi 

male-to-female, dirancang 

untuk mempermudah 

penghubungan komponen 

elektronik tanpa memerlukan 

solder. Kabel ini digunakan 

secara luas dalam proyek 

gambar 2.8 kabel micro 

USB 

gambar 2.9 Kabel Jumper 



 

21 

 

prototipe, terutama pada breadboard, untuk menghubungkan 

berbagai modul, sensor, atau mikrokontroler secara 

sementara(Efendi et al., 2022). 

 Dengan desain yang fleksibel dan konektor yang 

kompatibel dengan pin standar, kabel jumper memungkinkan 

perakitan rangkaian yang rapi dan mudah diubah sesuai 

kebutuhan eksperimen atau pengembangan. Misalnya, kabel 

ini dapat digunakan untuk menghubungkan modul relay ke 

mikrokontroler, sensor ke pin input, atau bahkan untuk 

membuat jalur antar titik koneksi pada breadboard. 

  Selain memberikan kemudahan dalam menyusun dan 

menguji rangkaian, kabel jumper juga memastikan koneksi 

yang stabil dan andal, menjadikannya alat esensial dalam 

pembelajaran elektronik, pengembangan sistem IoT, dan 

berbagai aplikasi lain yang memerlukan koneksi cepat dan 

fleksibel. 

2.3 Alat Pendukung 

a) Laptop atau PC 

Laptop atau PC dengan spesifikasi minimal prosesor Intel 

i5 atau setara, RAM 8GB, dan penyimpanan SSD adalah 

perangkat utama yang sangat penting untuk mendukung 

pengembangan sistem elektronik. Prosesor yang cepat 

seperti Intel i5 atau setara memberikan kemampuan 

pemrosesan yang cukup untuk menangani tugas-tugas 

intensif, seperti pemrograman mikrokontroler, 

menjalankan emulator, atau software debugging. RAM 

8GB memastikan perangkat dapat menjalankan beberapa 

aplikasi secara bersamaan tanpa mengalami lag, yang 

sangat membantu saat menggunakan Integrated 

Development Environment (IDE), seperti Arduino IDE 
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atau PlatformIO, sambil membuka browser atau aplikasi 

lain. Penyimpanan SSD meningkatkan kecepatan akses 

data dan booting sistem, sehingga alur kerja menjadi lebih 

efisien dan produktif. 

Laptop ini digunakan untuk memrogram 

mikrokontroler seperti ESP32-CAM, di mana kode 

dikembangkan, diuji, dan diunggah ke perangkat melalui 

koneksi USB(Yudistira et al., 2025). Selain itu, perangkat 

ini juga digunakan untuk menjalankan perangkat lunak 

desain sirkuit elektronik, seperti Fritzing, KiCad, atau 

Altium Designer, untuk merancang rangkaian dan layout 

PCB. Fungsi debugging sistem elektronik juga dilakukan 

melalui perangkat ini, baik menggunakan monitor serial 

untuk memantau komunikasi data maupun alat debug 

eksternal. Dengan spesifikasi tersebut, laptop atau PC ini 

menjadi perangkat penting yang mampu mendukung 

semua kebutuhan dalam proses pengembangan dan 

implementasi sistem elektronik secara cepat dan efisien. 

 

b) Smartphone atau tablet 

Smartphone atau tablet berperan sebagai 

perangkat penting dalam sistem IoT dengan fungsinya 

yang fleksibel dan serbaguna. Perangkat ini dapat 

digunakan sebagai alat kontrol jarak jauh untuk 

mengoperasikan perangkat elektronik, seperti membuka 

atau mengunci pintu melalui aplikasi tertentu. Selain itu, 

smartphone atau tablet juga digunakan untuk menerima 

notifikasi dari sistem, misalnya pemberitahuan status 

kunci pintu, deteksi aktivitas, atau kondisi sistem lainnya 

melalui platform seperti Telegram. 

Dengan kemampuan untuk mengakses jaringan 

internet dan mendukung aplikasi berbasis IoT, 

smartphone atau tablet memungkinkan pengguna untuk 

memantau dan mengontrol perangkat kapan saja dan di 

mana saja, memberikan kemudahan dan keamanan 
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tambahan. Kombinasi antara antarmuka yang ramah 

pengguna dan notifikasi real-time membuat perangkat ini 

menjadi bagian integral dari sistem otomatisasi modern. 

 

c) Router WiFi 

Router dengan kecepatan minimal 300Mbps 

adalah perangkat penting dalam membangun infrastruktur 

jaringan untuk mendukung sistem berbasis IoT. Dengan 

kecepatan ini, router mampu menangani transmisi data 

yang cepat dan stabil, memastikan koneksi yang andal 

antara perangkat mikrokontroler, seperti ESP32-CAM, 

dengan jaringan Wi-Fi. Router ini dirancang untuk 

mendukung komunikasi antar perangkat IoT, 

memungkinkan transfer data secara real-time, seperti 

mengirimkan notifikasi dari sensor ke smartphone atau 

mengontrol perangkat jarak jauh melalui aplikasi(Rifaini 

et al., 2021). 

Selain itu, router ini memiliki kemampuan untuk 

mengelola beberapa koneksi secara simultan, 

menjadikannya ideal untuk lingkungan dengan banyak 

perangkat IoT yang saling terhubung. Fitur keamanan 

bawaan pada router, seperti enkripsi WPA2, juga 

memberikan perlindungan terhadap akses yang tidak sah, 

memastikan sistem tetap aman. Dengan jangkauan sinyal 

yang luas dan kecepatan tinggi, router ini menjadi 

komponen penting dalam menciptakan ekosistem IoT 

yang efisien, responsif, dan mudah diakses dari berbagai 

perangkat pengguna. 
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BAB III 

PERSIAPAN SOFTWARE DAN HARDWARE 

3.1 Cara memilih komponen yang tepat 

a) Tentukan Kebutuhan Proyek 

1. Identifikasi tujuan utama proyek, seperti sistem IoT, 

kontrol otomatis, atau perangkat monitoring. 

2. Analisis fitur utama yang diperlukan, misalnya 

konektivitas Wi-Fi, pengendalian relay, atau deteksi 

aktivitas. 

 

b) Pilih Mikrokontroler yang Sesuai Pertimbangan 

1. Diperlukan konektivitas seperti Wi-Fi atau 

Bluetooth? Pilih mikrokontroler seperti ESP32-CAM. 

2. Kapasitas memori, jumlah pin I/O, dan kemampuan 

pemrosesan data. 

3. Rekomendasi: Gunakan ESP32 jika membutuhkan 

fungsi Wi-Fi dan Bluetooth bawaan untuk 

mendukung komunikasi IoT. 

 

c) Sesuaikan Daya Tahan dan Kapasitas Komponen 

Pilih komponen yang mampu menangani beban yang 

sesuai, seperti: 

1. Modul Relay: Pastikan arus maksimalnya (misalnya 

10A) cukup untuk mengontrol perangkat seperti 

solenoid. 

2. Pastikan spesifikasi daya, seperti tegangan kerja 

solenoid atau buzzer, sesuai dengan sumber daya 

proyek. 

d) Perhatikan Fleksibilitas dan Skalabilitas 

1. Pilih komponen yang dapat digunakan untuk 

pengembangan proyek lebih lanjut. 
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2. Gunakan breadboard untuk prototipe agar rangkaian 

mudah diubah sebelum membuat desain permanen. 

 

e) Pertimbangkan Ukuran dan Kompatibilitas Fisik 

1. Pilih komponen dengan ukuran yang sesuai untuk 

ruang proyek, terutama jika sistem akan ditempatkan 

di area kecil. 

2. Pastikan konektor kompatibel, seperti kabel jumper 

male-to-male, female-to-female, atau kombinasi. 

 

f) Pilih Komponen Berkualitas Tinggi 

1. Gunakan komponen dari produsen terpercaya untuk 

memastikan keandalan dan durabilitas. 

2. Hindari komponen murah tanpa spesifikasi jelas yang 

dapat merusak sistem. 

 

g) Evaluasi Kebutuhan Daya 

1. Tentukan kebutuhan daya dari setiap komponen, dan 

pastikan sumber daya seperti adaptor atau power 

supply mampu menyuplai arus yang cukup tanpa 

overloading. 

 

h) Perhatikan Kemudahan Penggunaan 

1. Pilih modul atau komponen yang sudah memiliki 

dokumentasi dan dukungan luas, seperti Arduino IDE 

untuk pemrograman mikrokontroler. 

2. Komponen seperti buzzer aktif atau modul relay pre-

built lebih mudah digunakan daripada merakit dari 

nol. 

i) Uji Kompatibilitas Antar Komponen 

Pastikan komponen dapat berfungsi bersama, misalnya: 

1. Router mendukung frekuensi Wi-Fi yang sesuai 

dengan ESP32-CAM. 
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2. Tegangan output dari modul relay sesuai dengan 

spesifikasi solenoid. 

 

j) Sesuaikan dengan Anggaran 

1. Tentukan prioritas fitur dan pilih komponen dengan 

harga yang sesuai tanpa mengorbankan kualitas. 

2. Bandingkan beberapa pilihan untuk menemukan 

komponen yang terbaik untuk proyek. 

Dengan mempertimbangkan aspek-aspek di atas, kita dapat 

memilih komponen yang tepat, sehingga proyek elektronik 

berjalan dengan optimal, efisien, dan sesuai kebutuhan(Arri 

Ape Pane Basabilik Prodi Fisika et al., 2021). 

3.2 Flowchart Mekanisme Kerja Sistem 

Struktur Urutan Flowchart Sistem Pintu Otomatis dengan 

ESP32-CAM 

a) Mulai yaitu Sistem dinyalakan dan siap bekerja. 

b) Koneksi WiFi yaitu Sistem memastikan koneksi ke 

jaringan WiFi. 

c) Tombol bell ditekan, Saat seseorang menekan tombol 

bel, sistem akan mengaktifkan kamera dan mengirim 

notifikasi. 

d) ESP32-CAM aktif 

a) Mengambil Foto → Kamera menangkap gambar 

pengunjung. 

b) Mengirim Foto ke Telegram → Gambar dikirim 

ke pengguna. 
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c) Mengirim Notifikasi ke Telegram → 

Pemberitahuan dikirim agar pengguna tahu ada 

tamu di depan pintu. 

e) Telegram 

a) Pengguna menerima foto dan notifikasi melalui 

Telegram.  

b) Pengguna bisa memutuskan apakah ingin 

membuka pintu atau tidak. 

f) Pintu dibuka atau ditutup 

a) Jika Yes (Pengguna ingin membuka pintu) → 

Solenoid lock terbuka. 

b) Jika No (Pengguna tidak ingin membuka pintu) 

→ Sistem kembali ke langkah Tombol Bel 

Ditekan, menunggu bel ditekan lagi. 

g) Jika yes, pintu terbuka 

a) Solenoid lock melepaskan kunci, sehingga pintu 

bisa dibuka. 

h) Selesai  

• Sistem kembali ke kondisi awal untuk terus 

memantau dan siap menerima input berikutnya. 
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gambar 3.1 Flowchat mekanisme kerja 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3 Instalasi Arduino IDE 

Berikut adalah langkah-langkah untuk mendownload Arduino 

IDE dari situs resmi Arduino: 

a) Buka Situs Arduino 

Buka browser dan kunjungi situs resmi Arduino di 

https://www.arduino.cc/en/software. 

https://www.arduino.cc/en/software
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gambar 3.2 Instal Arduino IDE 

 

b) Pilih Versi Arduino IDE 

Di halaman tersebut, kamu akan melihat pilihan untuk 

mendownload Arduino IDE untuk berbagai sistem 

operasi: Windows, macOS, dan Linux. Pilih sesuai 

dengan sistem operasi yang kamu gunakan. 

1. Untuk Windows, ada dua pilihan: versi installer atau 

zip. Disarankan untuk memilih Windows Installer. 

 

 

 

 

 

 

 

 

 

 

2. Untuk macOS dan Linux, pilih versi yang sesuai 

dengan sistem operasi kamu. 

3. Setelah memilih versi yang sesuai, klik versi yang 

telah kita pilih tadi. 

 

c) Setelah memilih versi yang sesuai, klik tombol "Just 

Download" untuk mulai mendownload file installer.  
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gambar 3.3 Install Arduino IDE 

gambar 3.4 Install Arduino IDE 

 

 

 

 

 

 

 

 

 

Kamu juga bisa memilih untuk mendonwload versi berbayar, tapi 

biasanya yang just download sudah cukup.  

d) Klik “just download” kembali untuk memulai 

downloadnya. 

e) Tunggu proses download hingga selesai. 

f) Setelah selesai didownload, buka file untuk proses 

instalasi. 

g) Setujui persyaratan lisensi. Pada tampilan awal, kita akan 

diminta untuk menyetujui persyaratan lisesnsi. Klik “I 

agree” 
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gambar 3.5 Instalasi Arduino IDE 

gambar 3.6 Instalasi Arduimo IDE 

 

 

 

 

 

 

 

 

 

 

h) Klik “next” untuk melanjutkan.  

 

 

 

 

 

 

 

 

i) Lalu klik “install” dan tunggu hingga penginstalannya 

selesai. 
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gambar 3.7 instalasi Arduino IDE 

gambar 3.8 Instalasi library 

j) Klik finish untuk memulai Arduino IDE nya. 

 

 

 

 

 

 

 

 

k) buka aplikasi arduino IDE di laptop/pc. Setelah terbuka, 

dibagian bawah cari dan klik opsi “Install All” untuk 

menginstal seluruh pustaka yang terdaftar sekaligus.  

l) Pastikan leptop atau pc terhubung ke internet agar proses 

pengunduhan dan instalasi dapat berjalan dengan lancar 

 

 

 

Proses ini mungkin memerlukan bebrapa waktu 

tergantung pada jumlah library yang diunduh serta 

kecepatan koneksi internet. 
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gambar 3.9 Library manager 

gambar 3.10 Library manager 

3.4 Instalasi Library Manager 

a) Library Blynk. Klik Tools > Manage Libraries gambar 

memori seperti dibawah ini. 

 

 

 

 

 

 

 

 

 

 

 

b) Di kolom “file your search, ketik blynk. Lalu install 

 

 

 

 

 

 

 

 

 

 

 

 

c) Dengan cara yang sama, install juga library DHT11, 

Ctbot, Thingspeak dan BMP280. 
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gambar 3.13 thingSpeak 

gambar 3.11 Library DHT11 

gambar 3.14 BMP280 

gambar 3.12 Library ctbot 
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gambar 4.2 Konfigurasi 

gambar 4.1 Konfigurasi 

BAB IV 

KONFIGURASI SISTEM TAMBAHAN 

4.1 Konfigurasi ESP32 pada Arduino ide 

a) Buka Arduino IDE lalu masuk ke menu File > 

Preferences. 

 

 

 

 

 

 

 

 

 

 

 

 

 

b) Pada bagian bawah jendela Preferences, cari kolom 

“Additional Boards Manager URLs”. 
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gambar 4.3 Konfigurasi 

gambar 4.4 konfigurasi 

Isikan URL 

https://dl.espressif.com/dl/package_esp32_index.json 

 

 

 

 

 

 

 

 

 

c) Setelah itu klik tombol OK dua kali untuk menyimpan 

pengaturan.  

d) Selanjutnya klik gambar memori seperti gambar dibawah 

ini. 

 

 

 

 

 

 

 

 

 

 

 

 

https://dl.espressif.com/dl/package_esp32_index.json
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gambar 4.5 konfigurasi 

e) Pada kolom “filter your search...” ketik ESP32 hingga 

muncul daftar paket ESP32.  

 

 

 

 

 

 

 

 

  

Pilih ESP32 by espressif systems lalu klik install. 

Tunggu hingga proses instalasi selesai. Pastikan laptop 

atau komputer terhubung ke internet selama proses ini. 

f) Setelah instalasi selesai, masuk ke menu Tools > Board > 

Select other board and port. 

 

g) Pada kolom pencarian board, ketikkan ESP32 dan pilih 

ESP32 Dev Module (untuk modul ESP32 umum). Pilih 

nomor port sesuai dengan nomor com ESP32 yang 

terdeteksi di laptop.  
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gambar 4.7 konfigurasi 

 

 

 

 

 

 

 

 

 

 

Pada tahap ini, modul ESP32-CAM harus terhubung 

dengan laptop. Terakhir klik OK. 

 

h) Ulangi sekali lagi, pilih AI Thinker ESP32-CAM 

(khusus ESP32-CAM). Pilih nomor port sesuai dengan 

nomor com yang terdeteksi di laptop. 

 

 

 

 

 

 

 

 

 Ketika sudah selesai, klik OK. 
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gambar 4.9 NodeMCU 

gambar 4.8 NodeMCU 

4.2 Penambahan Board NodeMCU V3 di Arduino IDE 

a) Buka Arduino IDE dan pilih menu File > Preferences. 

 

 

 

 

 

 

  

 

 

 

 

 

b) Pada bagian bawah jendela Preferences, temukan kolom “ 

Additional Boards Manager URL”. Masukkan URL 

berikut: 

http://arduino.esp8266.com/stable/package_esp8266com

_index.json 

 

 

 

 

 

 

 

 

 

 

Klik OK untuk menyimpan pengaturan. 

 

http://arduino.esp8266.com/stable/package_esp8266com_index.json
http://arduino.esp8266.com/stable/package_esp8266com_index.json
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gambar 4.10 NodeMCU 

gambar 4.11 NodeMCU 

c) klik gambar memori seperti di langkah sebelumnya.  

 

 

 

 

 

 

 

 

 

 

 

Pada kolom “Search your file” ketik ESP8266. Pilih 

ESP8266 by ESP8266 Comunity, lalu klik tombol 

Install.Tunggu hingga proses instalasi selesai. Pastikan 

laptop atau pc terhubung ke internet selama proses ini. 

 

d) Untuk memilih board dan port untuk NodeMCU, masuk 

ke menu Tools > Board > Select Other Board and Port. 

 

e) Ketik NodeMCU di Boards kemudian pilih NodeMCU 

1.0 (ESP-12E Module). Pilih nomor port sesuai dengan 

nomor com NodeMCU yang terdeteksi laptop. 
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gambar 4.12 Bot telegram 

gambar 4.13 bot telegram 

4.3 Pengaturan bot Telegram 

a) Unduh dan install aplikasi telegram di smartphone sesuai 

perangkat yang digunakan. Pastikan perangkat memiliki 

akses ke internet dan cukup ruang penyimpanan. 

1. Android : melalui Google play store 

2. iOS : melalui App store 

b) setelah telegram terinstal, buka aplikasi dan login 

menggunakan nomor telepon. 

c) Pada halaman utama, gunakan kolom pencarian di bagian 

atas untuk mencari akun BotFather atau ketik username 

@BotFather.  

 

  
 

Pilih akun yang memiliki tanda centang biru 

(menunjukkan akun resmi). 

d) Setelah masuk ke chat dengan BotFather, klik “restart” 

atau “mulai ulang” di bagian bawah layar. 

e) Ketik perintah “/newbot” di kolom chat dan kirimkan 

pesan tersebut untuk memulai proses pembuatan bot baru 
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gambar 4.14 bot telegram 

f) BotFather akan meminta nama untuk bot yang akan 

dibuat 

 

 

 

Ketik nama bot yang ingin dibuat, misalnya : Nadoorlock 

dan kirimkan pesan tersebut. Disclaimer, nama bot ini 

bersifat deskriptif. Jadi pilihlah nama yang 

menggambarkan fungsi bot tersebut. 

g) Setelah nama bot diterima, BotFather akan meminta nama 

untuk username. Username harus memenuhi syarat 

berikut: 

• Unik dan belum pernah digunakan oleh bot lain 

• Diakhiri dengan kata “bot”. Misalnya 

nadoorlockbot. Ketik username yang diinginkan 

dan kirimkan. 

 

h) Jika username berhasil dibuat, BotFather akan 

memberikan konfirmasi dengan pesan “Done!”. Pesan 

tersebut akan berisi token API yang unik untuk bot kita 

nanti. Token API ini sangat penting karena digunakan 

untuk mengintegrasikan bot dengan program lain seperti 

Arduino. Selanjutnya salin token API ini dan simpan di 

tempat yang aman karena kita memerlukannya di langkah 

berikutnya. 

i) Aktifkan bot dengan cara mengklik username bot yang 

telah kita buat melalui pesan yang dikirim oleh BotFather 

tadi.  
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gambar 4.15 bot telegram 

 

 

 

 

 

 

Lalu klik “start” atau “mulai” di chat bagian bawah untuk 

mengaktifkan bot dan memastikan bot sudah siap 

menerima perintah. 

j) Gunakan bot untuk mendapatkan Chat ID. Caranya 

dengan ketik “Get Chat ID” atau dengan username 

“@GetChatID_IL_BOT” untuk mengetahui Chat ID. 

Setelah mendapatkan Chat ID, catat  dan simpan 

informasi tersebut. ID ini diperlukan bersama token API 

untuk integrasi di program Arduino IDE. 

 

k) Kumpulkan informasi penting dari ketiga hal yang tadi 

yaitu : 

• Nama bot = nama deskriptif bot 

• Token API = token unik dari BotFather 

• Chat ID = identitas pengguna atau grup yang akan 

menerima pesan dari bot 
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gambar 5.1 koneksi ESP32-CAM 

gambar 5.2 Konfigurasi ESP32 

BAB V 

PEMROGRAMAN SISTEM 

5.1 Kode dasar ESP32-CAM 

Sebelum memulai pemrograman ESP32-CAM dengan 

Arduino IDE, pastikan Arduino IDE sudah terinstal di laptop 

dan ESP32 board sudah di install di Arduino IDE. 

a) Koneksikan board ESP32-CAM ke laptop dengan kabel 

USB. 

 

 

 

 

 

 

b) Buka Arduino IDE, setting board agar menjadi “I Thinker 

ESP32-CAM, serta sesuaikan nomor port nya yang 

terdeteksi di laptop. 
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gambar 5.4 Upload Program 

gambar 5.3 Testing LED flash 

c) Selanjutnya membuat program testing LED Flash. Pada 

program ini, akan menguji koneksi antara ESP32-CAM 

dengan laptop. 

Didalam board 

ESP32-CAM sudah 

ada Flash yang dapat 

kita pakai untuk 

testing. LED flash 

terhubung dengan 

GPIO-4. Tulis 

program berikut: 

 

d) Lalu klik File > Save. Save dengan nama tanpa spasi. 

Contoh Led_kita_semua. Selanjutnya kita upload dengan 

mengklik tanda panah atas seperti gambar dibawah 
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gambar 5.5 Output Program 

gambar 5.6 Testing ESP32 

gambar 5.7 Testing ESP32 

gambar 5.8 Testing ESP32 

e) Setelah berhasil upload, maka tampilannya akan seperti 

gambar dibawah ini dan LED Flash akan berkedip selama 

5 kali. 

 

 

 

 

5.2 Program testing antara ESP32-CAM dengan Web 

Server.  

a) Siapkan sebuah WiFi atau hostpot. Siapkan SSID ( nama 

wifi dan password. Lalu sambungkan ESP32-CAM 

dengan laptop. 

b) Buka Arduino IDE, klik File > Example > ESP32 > 

Camera > CameraWebServer. Pada source code  

 

 

 

Tambahkan “//” agar menjadi tanda komentar seperti ini. 

 

 

 

 

c) Pada source code dibawah ini 

 

 

 

Hilangkan tanda “//” atau tanda komentar menjadi seperti 

ini. 
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gambar 5.12 Testing ESP32 

gambar 5.10 Testing ESP32 

gambar 5.9 Testing ESP32 

gambar 5.11 Testing ESP32 

 

 

 

d) Ubah dan masukkan nama WiFi dan Password yang telah 

di siapkan didalam source ini. 

 

 

 

 

e) Di file app_httpd.ccp, pada baris 286 sampai dengan 289 

ditambah dl_lib_ menjadi dl_lib_free. 

 

 

 

 

 

 

 

 

 

 

 

 

f) Begitu juga di baris 385 sampai dengan 388. 
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gambar 5.13 Testing ESP32 

gambar 5.14 Testing ESP32 

gambar 5.15 Testing ESP32 

g) Simpan program tersebut dengan klik File > Save lalu 

upload. Setelah berhasil upload, buka serial monitor  

 

 

 

 

 

 

 

h) Pilih 115200 baud dan juga Both NL & CR 

 

 

 

 

Setelah itu, tekan dan tahan tombol reset (RST) pada 

ESP32-CAM selama beberapa detik, lalu lepaskan untuk 

merestart perangkat dan memastikan bahwa sistem mulai 

berjalan dengan benar. 
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gambar 5.16 Testing ESP32 

gambar 5.17 Testing ESP32 

 sehingga muncul alamat IP nya. 

 

 

 

 

i) Copy alamat web tersebut kemudian paste di browser 

sehingga muncul tampilan berikut ini. Pastikan memakai 

jaringan Wifi yang sama antara ESP32-CAM dengan 

Laptop.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

f) Untuk mengaktifkan camera, silahkan scrol kebawah lalu 

klik Start Stream. Lalu balik scrol ke atas kembali, pilih 

resolusi kamera menjadi CIF (400x296). Lanjut scrol ke 

bawah lagi untuk mengaktifkan face detection kemudian 

balik ke atas lagi untuk melihat apakah ada wajah yang 
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gambar 5.18 Testing ESP32 

terdeteksi. Berikutnya untuk merekam wajah, silahkan 

aktifkan Face Recognition kemudian klik Enroll Face. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

g) Posisikan wajah pada kamera dan tunggu sampai selesai 

mengiden-tifikasi dan merek-am wajah.  

Tunggu sampai selesai merekam wajah, jika sudah 

tersimpan maka tampilan keterangannya dalah “Hello 

Subject 1”. Untuk merekam wajah berikutnya prosesnya 

sama. 

 

5.3 Skematik Rangkaian Proyek 

 Pada bagian ini, akan dijelaskan rangkaian skematik 

yang digunakan dalam proyek sistem kendali keamanan pintu 

pagar berbasis ESP32-CAM. Rangkaian ini dirancang untuk 

mengintegrasikan berbagai komponen elektronik agar dapat 

bekerja secara terpadu dalam mengendalikan kunci pintu 
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gambar 5.18 Rangkaian Proyek 

secara otomatis menggunakan teknologi pengenalan wajah 

dan notifikasi Telegram. 

 

 

 

 

 

 

 

 

 

 

 

 

 Komponen utama dalam sistem ini adalah ESP32-

CAM, yang berfungsi sebagai unit pemrosesan utama 

sekaligus kamera untuk mendeteksi wajah pengguna. ESP32-

CAM akan memproses data citra yang ditangkap dan 

membandingkannya dengan basis data wajah yang tersimpan. 

Jika wajah dikenali, ESP32-CAM akan mengirimkan sinyal 

ke modul relay untuk mengaktifkan solenoid door lock, yang 

bekerja pada tegangan 9V. 

 Selain itu, sistem ini juga dilengkapi dengan tombol 

push button sebagai input manual untuk membuka kunci 

secara langsung tanpa perlu deteksi wajah, serta buzzer 

sebagai indikator suara yang memberikan respons terhadap 

status sistem. Modul relay 5V digunakan untuk mengontrol 

arus ke solenoid door lock agar bekerja dengan aman dan 

efisien. 
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Dari segi catu daya, sistem ini memanfaatkan dua sumber 

daya, yaitu 5V/2A untuk ESP32-CAM dan rangkaian kontrol, 

serta 9V/2A untuk solenoid door lock. Kedua sumber daya ini 

memastikan setiap komponen mendapatkan tegangan yang 

sesuai untuk operasional yang stabil. 

 

Dengan rancangan skematik ini, sistem dapat bekerja secara 

otomatis dalam mengontrol akses pintu pagar berdasarkan 

hasil deteksi wajah, serta memberikan notifikasi melalui 

aplikasi Telegram sebagai fitur tambahan untuk meningkatkan 

keamanan. Berikut adalah skema rangkaian yang digunakan 

dalam proyek ini. 
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BAB VI 

PENGUJIAN SISTEM 

6.1 Integrasi Telegram dan ESP32-CAM 

 Program dalam proyek ini membutuhkan library 

UniversalTelegramBot.h versi terbaru agar dapat berfungsi 

dengan optimal. Library ini sangat penting karena digunakan 

untuk berkomunikasi dengan layanan Telegram Bot API, yang 

memungkinkan interaksi antara perangkat dan bot Telegram 

secara efisien. 

 

 Menggunakan versi terbaru dari Universal Telegram 

Bot memberikan berbagai keuntungan, seperti peningkatan 

performa, perbaikan bug, serta fitur-fitur terbaru yang 

mungkin tidak tersedia pada versi sebelumnya. Oleh karena 

itu, memastikan bahwa proyek menggunakan versi terbaru 

dari library ini akan membantu dalam menjaga stabilitas dan 

kompatibilitas dengan perubahan yang terjadi pada Telegram 

API. 

 

 Untuk menginstal atau memperbarui library ini, 

pengguna dapat mengunduhnya langsung dari Arduino 

Library Manager atau repositori GitHub resminya. Jika sudah 

terinstal versi lama, disarankan untuk memperbaruinya 

terlebih dahulu sebelum menjalankan proyek agar 

menghindari potensi error atau ketidaksesuaian dengan kode 

yang digunakan. 
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gambar 6. 1 Library dalam integrasi 

gambar 6.2 Source Code 

 

 

 

 

 

 

 

 

 

 

 

Jika sudah diinstall, buka lembar kerja baru lalu masukkan 

source code dibawah ini. 
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gambar 6.3 Source Code 

gambar 6.4 Source Code 
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gambar 6.5 Source Code 

gambar 6.6 Source Code 
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gambar 6.7 Source Code 

gambar 6.8 Source Code 
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gambar 6.9 Source Code 

gambar 6.10 Source Code 
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gambar 6.11 Source Code 

gambar 6.12 Source Code 
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gambar 6.14 Penyesuaian Variabel 

 

Setelah semua source code dimasukkan, silahkan sesuaikan 

variabel berikut: 

• Nama jaringan WiFi atau Hostpot = ssid 

• Password Wifi atau Hostpot = Password 

• Token telegram = BOTtoken 

• ID Telegram = CHAT_ID 

 

 

 

gambar 6.13 Source Code 
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Setelah program selesai diketik dan disimpan, langkah selanjutnya 

adalah mengunggahnya ke ESP32-CAM. Pastikan board dan port 

sudah dikonfigurasi dengan benar di Arduino IDE sebelum 

melakukan upload. 

Setelah proses upload selesai, langkah berikutnya adalah 

membuka Serial Monitor di Arduino IDE untuk memantau status 

perangkat. Pastikan baud rate pada Serial Monitor sesuai dengan 

yang telah dikodekan dalam program, biasanya 115200 atau 9600, 

agar data yang ditampilkan dapat terbaca dengan jelas. 

Kemudian, tekan tombol RESET pada ESP32-CAM untuk 

menjalankan program yang telah diunggah. Tunggu beberapa saat 

hingga perangkat mulai melakukan inisialisasi dan mencoba 

menghubungkan diri ke jaringan WiFi yang telah dikonfigurasi 

dalam kode. Jika koneksi berhasil, Serial Monitor akan 

menampilkan alamat IP dari ESP32-CAM, yang dapat digunakan 

untuk mengaksesnya melalui browser atau aplikasi yang 

mendukung. 

Jika terjadi kendala seperti gagal terhubung ke WiFi, pastikan 

kembali bahwa SSID dan password WiFi yang dimasukkan sudah 

benar. Selain itu, periksa juga apakah sinyal WiFi cukup kuat di 

lokasi ESP32-CAM berada. Jika masih mengalami masalah, coba 

ulangi proses dari awal dengan melakukan pengecekan terhadap 

kode program dan koneksi perangkat. 

Setelah berhasil mengunggah program ke ESP32-CAM, langkah 

berikutnya adalah menunggu perangkat terhubung ke jaringan 

internet atau WiFi. Indikator koneksi dapat dilihat melalui LED 

status pada ESP32-CAM: 
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a) Jika LED berwarna biru berkedip hanya beberapa kali lalu 

berhenti, berarti perangkat telah berhasil terhubung ke 

jaringan. 

b) Jika LED merah berkedip terus-menerus, kemungkinan 

terdapat masalah dalam koneksi WiFi. Dalam kasus ini, 

lakukan langkah-langkah berikut: 

1. Reset ESP32-CAM dengan menekan tombol RESET pada 

modul. 

2. Periksa kembali apakah SSID dan password WiFi yang 

dimasukkan dalam kode sudah benar. 

3. Pastikan jaringan WiFi memiliki sinyal yang cukup kuat 

dan tidak ada kendala teknis seperti pemblokiran perangkat 

baru oleh router. 

6.2 Koneksi Telegram dengan ESP32-CAM 

Setelah ESP32-CAM berhasil terhubung ke internet, 

langkah berikutnya adalah mulai menggunakan fitur 

notifikasi Telegram. Berikut caranya: 

1. Buka aplikasi Telegram di ponsel atau komputer. 

2. Cari dan buka chat bot "ESP32CAM DOOR LOCK" yang 

telah dikonfigurasi sebelumnya.  

3. Klik tombol "Mulai" (Start) untuk memulai proses dan 

mengaktifkan komunikasi dua arah antara bot dan 

perangkat ESP32-CAM, sehingga perangkat dapat 

menerima serta mengirim data secara real-time. 
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gambar 6.15 Perintah Telegram 

 

 

 

 

 

 

 

 

 

Setelah bot Telegram ESP32CAM DOOR LOCK aktif dan 

terhubung dengan ESP32-CAM, kita dapat mengontrol kunci 

pintu menggunakan perintah yang tersedia. Berikut langkah 

langkahnya: 

1. Ketik atau pilih perintah /lock di chat bot Telegram. 

2. Setelah perintah dikirim, ESP32-CAM akan menerima 

instruksi dan mengubah status solenoid ke OFF, yang berarti 

kunci dalam kondisi terkunci. 

3. Pada saat yang sama, relay akan dalam keadaan OFF, sehingga 

tidak ada arus yang mengaktifkan solenoid. 
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gambar 6.16 Perintah Telegram 

 

 

 

 

 

 

 

 

 

4. Bot Telegram akan mengonfirmasi perubahan ini dengan 

menampilkan pesan "Pintu Sudah Terkunci. /unlock". Pesan 

ini juga memberi opsi untuk membuka kembali kunci dengan 

perintah /unlock. 

Pastikan perangkat tetap terhubung ke internet agar perintah dari 

Telegram dapat diproses dengan lancar. Jika terjadi kendala, 

periksa koneksi ESP32-CAM dan pastikan bot Telegram sudah 

dikonfigurasi dengan benar. 

Saat tombol bell (tactile switch) ditekan, sistem akan menjalankan 

serangkaian proses sebagai berikut: 

 

 



 

65 

 

gambar 6.17 Perintah Telegram 

 

 

 

 

 

 

 

 

 

 

1. Buzzer akan berbunyi sebagai tanda bahwa ada seseorang yang 

menekan tombol bell. 

2. ESP32-CAM akan mengambil foto pengunjung menggunakan 

kamera bawaan. 

3. Setelah itu, pesan notifikasi akan dikirim ke bot Telegram 

dalam bentuk teks dan gambar. Pesan yang diterima di 

Telegram akan menampilkan "Tombol bell ditekan, /terima 

atau /tolak". Foto pengunjung juga akan disertakan dalam 

pesan Telegram untuk membantu dalam identifikasi. 

Pengguna dapat memilih untuk membuka kunci pintu dengan 

mengklik /terima, atau mengabaikan permintaan dengan memilih 

/tolak. 
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Pastikan ESP32-CAM tetap terhubung ke jaringan WiFi agar 

proses pengiriman notifikasi dan foto ke Telegram berjalan 

dengan lancar. Jika ada kendala, periksa kembali koneksi internet, 

konfigurasi bot Telegram, serta respons dari perangkat keras 

seperti buzzer dan kamera. 

Mekanisme Penolakan Pengunjung pada Sistem ESP32-

CAM Door Lock 

1. Penolakan Manual dengan Perintah /tolak. Jika tombol bell 

ditekan tetapi pengunjung tidak diterima, pengguna dapat 

menekan perintah /tolak di bot Telegram. Setelah perintah 

dikirim, sistem akan menjalankan Buzzer berbunyi sebagai 

tanda bahwa pengunjung ditolak. LED biru berkedip sebagai 

indikator penolakan. Pesan notifikasi dikirim ke Telegram 

dengan teks "Pengunjung ditolak, buzzer telah dibunyikan." 

2. Penolakan Otomatis Setelah 20 Detik. Jika tombol bell 

ditekan tetapi tidak ada respons dari pengguna dalam waktu 

20 detik (tidak memilih /terima atau /tolak), sistem akan 

otomatis menolak pengunjung dengan Buzzer berbunyi untuk 

memberi tanda bahwa waktu respon telah habis. LED biru 

berkedip sebagai indikator bahwa pengunjung ditolak. Pesan 

otomatis dikirim ke Telegram dengan teks: "Pengunjung 

telah ditolak otomatis." 

Sistem ini memastikan bahwa setiap permintaan masuk 

mendapatkan respons, baik secara manual oleh pengguna atau 

secara otomatis setelah batas waktu tertentu. Pastikan ESP32-

CAM tetap terhubung ke internet agar semua notifikasi dapat 

diterima di Telegram dengan lancar. 
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6.3 Source Code Pengenalan wajah Otomatis 

 

1. Mekanisme Pengenalan Wajah pada Sistem ESP32-CAM 

Door Lock 

Saat seseorang berada di depan pintu, kamera ESP32-

CAM akan secara otomatis mengambil gambar wajahnya. 

Gambar ini kemudian diproses oleh sistem yang telah 

dilengkapi dengan algoritma pengenalan wajah untuk 

menentukan apakah individu tersebut memiliki akses atau 

tidak. 

Proses identifikasi dilakukan dengan menganalisis fitur 

unik pada wajah, seperti bentuk wajah, posisi mata, hidung, 

dan mulut. Sistem akan membandingkan data wajah yang 

baru saja terdeteksi dengan database wajah yang telah 

terdaftar sebelumnya. 

Jika wajah yang terdeteksi cocok dengan data yang 

tersimpan, sistem akan mengirimkan sinyal untuk membuka 

kunci pintu, memungkinkan akses masuk. Sebaliknya, jika 

wajah tidak dikenali atau tidak terdapat dalam database, 

sistem akan menolak akses dan memastikan pintu tetap 

terkunci untuk menjaga keamanan. 

Dengan metode ini, sistem memastikan bahwa hanya 

individu yang telah terdaftar yang dapat membuka pintu, 

meningkatkan tingkat keamanan serta kenyamanan dalam 

penggunaan sistem akses otomatis berbasis ESP32-CAM. 
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2. Kebutuhan Jaringan Internet 

Untuk mengoperasikan ESP32-CAM, diperlukan koneksi 

WiFi (hotspot) agar perangkat dapat berkomunikasi dengan 

bot Telegram dan menjalankan fitur kendali jarak jauh. Anda 

dapat menggunakan router WiFi atau hotspot dari ponsel 

(tethering) sebagai sumber jaringan. 

Berikut yang perlu disiapkan: 

a. Nama jaringan WiFi (SSID) 

b. Password WiFi 

Pastikan jaringan WiFi memiliki sinyal yang stabil dan 

mendukung perangkat IoT agar ESP32-CAM dapat terhubung 

dengan lancar. antara ESP32-CAM dan komponen hardware 

lainnya masih sama seperti yang telah dibahas sebelumnya. 

Namun, dalam konfigurasi ini tidak menggunakan tombol 

bell, sehingga skema rangkaian lebih  

Berikut daftar file yang perlu disertakan dalam folder proyek: 

1. camera_index.h 

2. camera_pins.h 

3. partitions.csv 

4. rzo_partitions.csv 

5. Program_Face_Door_ESP32Cam.ino  

Source code bisa diambil lewat link yang ada di 

caption dengan nama Program_Face_Door_ESP32Cam. 

Pastikan semua file sudah tersedia dalam direktori yang sama 

dengan Program_Face_Door_ESP32Cam.ino agar sistem 

dapat bekerja dengan baik tanpa error saat kompilasi. Jika ada 
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gambar 6.18 Koneksi Telegram 

kendala dalam mengunggah program, periksa kembali koneksi 

perangkat, pengaturan board di Arduino IDE, serta konfigurasi 

partisi yang sesuai dengan ESP32-CAM. 

Pada file Program_Face_Door_ESP32Cam.ino, 

sesuaikan kembali variabel SSID dan Passwordnya. Setelah 

disesuaikan, simpan lalu upload. 

Setelah program selesai diunggah ke ESP32-CAM, 

langkah berikutnya adalah memastikan perangkat dapat 

berjalan dengan baik dan terhubung ke jaringan WiFi. Buka 

Serial Monitor di Arduino IDE untuk memantau status 

perangkat secara real-time lalu Tekan tombol RESET pada 

ESP32-CAM untuk menjalankan program yang telah 

diunggah. Tunggu beberapa saat hingga perangkat mulai 

melakukan inisialisasi dan mencoba terhubung ke jaringan 

WiFi. Setelah ESP32-CAM berhasil terhubung ke jaringan 

WiFi, langkah selanjutnya adalah mengakses kameranya 

melalui browser di handphone. 

Berikut langkahnya: 

1. Cek Serial Monitor di Arduino IDE, cari alamat IP yang 

diberikan oleh router WiFi untuk ESP32-CAM. Alamat ini 

berbentuk 192.168.x.x  
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gambar 6.19 Tampilan antarmuka 

2. Buka aplikasi browser di handphone, seperti Google Chrome, 

Mozilla Firefox, atau browser bawaan. 

3. Ketik alamat IP ESP32-CAM yang terlihat di Serial Monitor 

ke dalam bilah alamat browser, lalu tekan Enter. 

4. Jika koneksi berhasil, halaman antarmuka ESP32-CAM akan 

muncul, menampilkan tampilan dari kamera secara real-time. 

 

 

 

 

 

 

Jika halaman tidak terbuka, coba lakukan beberapa langkah 

berikut: 

1. Pastikan handphone terhubung ke jaringan WiFi yang 

sama dengan ESP32-CAM. 

2. Cek kembali alamat IP di Serial Monitor, pastikan tidak 

ada kesalahan dalam mengetiknya. 

3. Jika masih tidak bisa diakses, coba reset ESP32-CAM dan 

ulangi langkah-langkah di atas. 

Setelah berhasil mengakses tampilan kamera, kita dapat 

menggunakan fitur yang tersedia sesuai dengan program yang 

telah diunggah. 
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gambar 6.20 Proses Penyimpanan Sistem 

6.4 Proses Jalannya Alat 

1. Menyimpan Wajah ke Sistem 

Setelah berhasil mengakses antarmuka kamera ESP32-

CAM melalui browser, langkah selanjutnya adalah 

mendaftarkan wajah agar bisa dikenali oleh sistem. 

2. Pada halaman antarmuka, cari kolom "Type the person’s 

name here". 

 

 

 

 

 

3. Ketik nama yang ingin disimpan, misalnya: Aci. 

4. Klik tombol "ADD USER" untuk menyimpan wajah ke 

dalam sistem. 

5. Tunggu beberapa saat hingga wajah berhasil dikenali dan 

disimpan dalam database perangkat. 

6. Setelah wajah tersimpan, Anda dapat mengaktifkan akses 

kTekan tombol "ACCESS CONTROL" pada antarmuka. 

7. Jika wajah yang terdeteksi sesuai dengan wajah yang 

sudah terdaftar, sistem akan mengaktifkan relay (ON), 

yang berarti pintu akan terbuka. 

8. Relay akan tetap ON selama 20 detik, memberikan waktu 

bagi pengguna untuk masuk. 

9. 5 detik sebelum batas waktu habis, buzzer akan berbunyi 

setiap detiknya sebagai peringatan bahwa pintu akan 
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segera terkunci. Ketika waktu habis, relay akan OFF, 

sehingga pintu terkunci kembali secara otomatis. 

Fungsi Tambahan 

1. Detect Face digunakan untuk mendeteksi wajah orang yang 

berada di depan kamera ESP32-CAM. 

2. Delete All digunakan Menghapus semua data wajah yang 

telah tersimpan dalam sistem. 

3. Menghapus Wajah Individu cukup tekan ikon silang (X) di 

samping nama orang tersebut. 

Dengan fitur ini, sistem ESP32-CAM dapat mengelola akses pintu 

secara otomatis menggunakan pengenalan wajah, serta 

memungkinkan pengguna untuk menambah, mendeteksi, atau 

menghapus data wajah dengan mudah. 

6.5 Uji Coba Proyek 

Simak uji coba proyek ini secara langsung melalui link video 

berikut  

https://youtu.be/h-1yPaZubUs?si=w18RQ-CUmPGhNRRG 

  

 

 

 

 

 

https://youtu.be/h-1yPaZubUs?si=w18RQ-CUmPGhNRRG
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BAB VII 

PENGAMANAN DAN  

PENINGKATAN PERFORMA SISTEM 

7.1 Enskripsi dan Proteksi Data dalam komunikasi 

Dalam sistem kendali berbasis IoT, keamanan 

komunikasi menjadi aspek krusial yang harus diperhatikan 

untuk mencegah akses tidak sah dan penyalahgunaan data. 

Mengingat ESP32-CAM berperan sebagai perangkat utama 

dalam sistem kendali pintu, data yang dikirimkan antara 

perangkat ini dan server harus dijaga keamanannya agar tidak 

mudah disadap atau dimanipulasi oleh pihak yang tidak 

berwenang. Jika komunikasi dalam sistem ini tidak 

diamankan dengan baik, risiko serangan seperti man-in-the-

middle attack (MitM), penyadapan data (sniffing), atau 

eksploitasi celah keamanan (vulnerabilities exploitation) 

dapat terjadi, yang berpotensi mengakibatkan 

pengambilalihan akses pintu oleh pihak luar (Muwardi & 

Adisaputro, 2021). Oleh karena itu, penerapan metode 

enkripsi yang kuat dan mekanisme autentikasi yang aman 

menjadi langkah utama dalam menjaga keamanan sistem. 

Salah satu metode enkripsi yang umum digunakan 

dalam komunikasi perangkat IoT adalah AES (Advanced 

Encryption Standard). AES merupakan algoritma enkripsi 

simetris yang dikenal karena kecepatan dan tingkat 

keamanannya yang tinggi. Dengan menerapkan AES pada 

komunikasi antara ESP32-CAM dan server, data yang 

dikirimkan akan dikodekan menjadi format yang tidak dapat 

dibaca oleh pihak lain tanpa kunci dekripsi yang valid. Hal 
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ini sangat penting untuk memastikan bahwa setiap perintah 

atau informasi yang dikirim, seperti permintaan pembukaan 

pintu atau data wajah yang terdeteksi, tidak dapat diubah atau 

disalahgunakan oleh pihak yang tidak memiliki otorisasi. 

Selain enkripsi data, keamanan pada komunikasi 

dengan Telegram juga harus diperhatikan. Telegram 

digunakan sebagai media notifikasi sistem, di mana ESP32-

CAM akan mengirimkan pesan kepada pengguna saat ada 

aktivitas yang terdeteksi, seperti wajah yang berhasil 

diidentifikasi atau percobaan akses yang gagal. Untuk 

menjaga keamanan komunikasi ini, sistem harus 

menggunakan bot token sebagai identifikasi yang sah dalam 

mengakses API Telegram. Bot token ini harus disimpan 

dengan aman dan tidak boleh bocor ke publik karena dapat 

digunakan oleh pihak lain untuk mengakses bot dan 

mengirimkan perintah tanpa izin. Selain itu, komunikasi 

antara ESP32-CAM dan Telegram dilakukan melalui HTTPS 

(Hypertext Transfer Protocol Secure), yang mengenkripsi 

data yang dikirimkan melalui jaringan untuk mencegah 

penyadapan oleh pihak ketiga. Dengan kombinasi bot token 

yang unik dan penggunaan HTTPS, komunikasi antara sistem 

dan Telegram menjadi lebih aman dan sulit untuk 

diretas(Rahmawati et al., 2022). 

Untuk meningkatkan perlindungan terhadap akses 

tidak sah, sistem ini juga menerapkan teknik autentikasi 

pengguna. Salah satu metode autentikasi yang dapat 

digunakan adalah API keys, yang memastikan bahwa hanya 

aplikasi atau perangkat yang memiliki kunci API yang benar 

yang dapat mengakses sistem kendali pintu. Selain itu, 
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autentikasi berbasis wajah juga digunakan sebagai langkah 

verifikasi tambahan. Sistem hanya akan membuka pintu jika 

wajah yang terdeteksi cocok dengan data pengguna yang 

telah terdaftar, sehingga mencegah akses oleh orang yang 

tidak dikenal. Untuk mencegah manipulasi seperti 

penggunaan foto atau video untuk menipu sistem (spoofing), 

metode deteksi keaslian wajah (liveness detection) dapat 

diterapkan dengan memanfaatkan teknologi pemrosesan 

gambar yang lebih canggih. 

Dengan penerapan enkripsi data, komunikasi yang 

aman melalui Telegram, serta mekanisme autentikasi yang 

ketat, sistem kendali pintu berbasis ESP32-CAM dapat 

beroperasi dengan tingkat keamanan yang lebih tinggi. 

Langkah-langkah ini bertujuan untuk mencegah peretasan, 

penyadapan, dan akses ilegal, sehingga pengguna dapat 

merasa lebih aman dalam menggunakan sistem ini untuk 

kebutuhan sehari-hari. 

7.2 Risiko Keamanan pada Sistem Kendali Keamanan 

Sistem kendali pintu berbasis ESP32-CAM memiliki 

berbagai potensi risiko keamanan yang perlu diantisipasi 

untuk memastikan sistem tetap aman dari serangan atau 

eksploitasi pihak yang tidak bertanggung jawab. Mengingat 

sistem ini mengandalkan jaringan nirkabel dan komunikasi 

berbasis IoT, risiko terhadap serangan siber dan manipulasi 

fisik menjadi ancaman yang harus diperhitungkan. Jika 

sistem tidak dilindungi dengan baik, maka akses pintu dapat 

diretas, mengakibatkan pelanggaran keamanan yang 

berbahaya. 
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Salah satu ancaman utama dalam sistem ini adalah 

serangan siber, khususnya man-in-the-middle attack (MitM). 

Serangan ini terjadi ketika peretas menyusup di antara 

komunikasi antara ESP32-CAM dan server atau perangkat 

pengguna, memungkinkan mereka untuk mencuri atau 

memanipulasi data yang dikirim. Dalam konteks kendali 

pintu, seorang penyerang dapat mencegat sinyal perintah 

pembukaan pintu, merekamnya, lalu menggunakannya 

kembali (replay attack) untuk membuka pintu tanpa 

izin(Rasyidan et al., 2024). Selain itu, komunikasi berbasis 

protokol yang tidak aman dapat membuat sistem rentan 

terhadap penyadapan (sniffing), di mana data yang 

dikirimkan bisa diakses oleh pihak luar. 

Selain serangan berbasis jaringan, sistem ini juga 

rentan terhadap peretasan perangkat secara langsung, 

terutama jika ESP32-CAM dibiarkan dalam kondisi yang 

mudah diakses oleh orang asing. Eksploitasi firmware 

merupakan salah satu metode yang dapat digunakan oleh 

penyerang untuk memodifikasi atau menyuntikkan kode 

berbahaya ke dalam ESP32-CAM. Dengan mengeksploitasi 

celah keamanan dalam firmware, penyerang dapat 

mengambil alih kontrol perangkat dan mengakses pintu tanpa 

harus melewati mekanisme keamanan yang telah diterapkan. 

Selain itu, akses fisik ke perangkat juga menjadi ancaman, 

terutama jika seseorang dapat langsung menghubungkan 

perangkat ke komputer dan membaca data konfigurasi atau 

mengganti firmware dengan yang telah dimodifikasi. 

Sistem autentikasi wajah yang digunakan untuk 

membuka pintu juga tidak terlepas dari risiko keamanan. 
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Salah satu ancaman yang sering terjadi adalah spoofing 

dengan foto atau video, di mana seorang penyerang 

menggunakan gambar atau rekaman video pemilik asli untuk 

menipu sistem agar mengenali mereka sebagai pengguna 

yang sah. Jika sistem tidak memiliki mekanisme deteksi 

keaslian wajah (liveness detection), maka metode ini bisa 

digunakan untuk mengelabui sistem dan membuka pintu 

secara ilegal. 

Untuk mengatasi berbagai ancaman tersebut, 

diperlukan langkah-langkah mitigasi yang efektif, di 

antaranya: 

a) Menggunakan enkripsi data untuk melindungi komunikasi 

antara ESP32-CAM, server, dan perangkat pengguna. 

Dengan menerapkan protokol seperti AES atau TLS, data 

yang dikirimkan akan lebih sulit disadap atau 

dimanipulasi oleh pihak tidak berwenang. 

b) Memanfaatkan firewall dan VPN (Virtual Private 

Network) untuk membatasi akses jaringan hanya pada 

perangkat yang terotorisasi, sehingga mencegah serangan 

dari luar jaringan yang sah. 

c) Menerapkan sistem deteksi keaslian wajah (liveness 

detection) untuk membedakan wajah asli dengan gambar 

atau video. Teknologi ini dapat menggunakan deteksi 

kedipan mata, perubahan ekspresi, atau analisis 

kedalaman gambar untuk memastikan wajah yang 

dideteksi benar-benar milik pengguna yang sah. 

d) Mengamankan fisik perangkat ESP32-CAM, misalnya 

dengan memasangnya di lokasi yang sulit dijangkau oleh 
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orang asing dan menggunakan casing pelindung yang 

mencegah akses langsung ke port hardware. 

e) Memperbarui firmware secara berkala untuk mengatasi 

celah keamanan yang mungkin ditemukan pada versi 

sebelumnya, serta memastikan sistem selalu 

menggunakan teknologi keamanan terbaru(Kharisma et 

al., 2023). 

Dengan menerapkan langkah-langkah ini, risiko keamanan 

pada sistem kendali pintu berbasis ESP32-CAM dapat 

diminimalkan, sehingga sistem tetap aman dan dapat 

diandalkan untuk digunakan dalam berbagai lingkungan. 

7.3 Efisiensi Konsumsi daya 

Sistem kendali pintu berbasis ESP32-CAM dan 

solenoid 9V memerlukan strategi optimasi daya agar tetap 

hemat energi, terutama jika digunakan dalam jangka panjang 

atau di lokasi yang memiliki keterbatasan daya listrik. 

Efisiensi konsumsi daya sangat penting untuk memastikan 

perangkat dapat beroperasi tanpa sering mengganti sumber 

daya, mengurangi panas berlebih, serta meningkatkan daya 

tahan komponen. Tanpa optimasi yang baik, sistem dapat 

mengalami konsumsi daya berlebih yang menyebabkan 

pemborosan energi dan mengurangi masa pakai perangkat 

keras. Oleh karena itu, terdapat beberapa teknik yang dapat 

diterapkan untuk meningkatkan efisiensi daya sistem. 
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a) Optimasi Penggunaan Solenoid 

Solenoid pintu 9V bekerja dengan cara menarik 

atau mendorong mekanisme kunci ketika dialiri arus 

listrik. Salah satu kelemahan utama dari solenoid adalah 

konsumsi daya yang relatif tinggi, terutama jika dibiarkan 

aktif dalam waktu lama. Jika solenoid terus dialiri arus 

untuk mempertahankan posisi terbuka atau tertutup, maka 

akan menyebabkan pemborosan energi yang signifikan. 

Untuk mengatasi masalah ini, mekanisme 

penguncian berbasis latch atau kunci mekanik dapat 

diterapkan. Misalnya, menggunakan solenoid latching 

yang hanya membutuhkan daya sesaat untuk mengubah 

statusnya (buka/tutup) dan tidak perlu terus dialiri arus 

setelah berpindah posisi. Dengan mekanisme ini, solenoid 

hanya mengonsumsi daya saat terjadi perubahan status, 

sehingga dapat menghemat konsumsi energi secara drastis 

dibandingkan solenoid konvensional yang membutuhkan 

daya kontinu(Setyo et al., 2020). 

b) Sumber Daya yang Lebih Efisien. Dalam sistem yang 

dioperasikan di lingkungan yang sulit dijangkau oleh 

sumber listrik utama, diperlukan alternatif sumber daya 

yang lebih efisien dan berkelanjutan. Beberapa opsi yang 

dapat digunakan meliputi: 

1. Baterai Lithium: Menggunakan baterai 

lithium-ion atau lithium-polymer 

berkapasitas besar dengan pengontrol daya 

untuk memastikan suplai listrik tetap stabil. 

Baterai ini lebih efisien dibandingkan baterai 

alkalin biasa dan dapat diisi ulang, sehingga 
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lebih ekonomis untuk penggunaan jangka 

panjang. 

 

1. Panel Surya: Jika sistem ditempatkan di lokasi luar 

ruangan atau area dengan akses sinar matahari yang 

cukup, panel surya dapat menjadi solusi daya alternatif 

yang ramah lingkungan. Panel surya dapat digunakan 

untuk mengisi ulang baterai yang mendukung ESP32-

CAM dan solenoid, sehingga sistem dapat bekerja secara 

mandiri tanpa ketergantungan pada listrik PLN. 

 

2. Kapasitor Super (Supercapacitor): Untuk skenario 

tertentu, supercapacitor dapat digunakan sebagai 

penyimpanan daya jangka pendek yang mampu 

memberikan lonjakan daya tinggi saat solenoid diaktifkan, 

sekaligus mengurangi tekanan pada sumber daya utama. 

Dengan penerapan optimasi penggunaan solenoid, serta 

pemanfaatan sumber daya yang lebih efisien, sistem 

kendali pintu dapat beroperasi dengan konsumsi daya 

yang lebih hemat tanpa mengurangi 

fungsionalitasnya(Syaban et al., 2024). Langkah-langkah 

ini tidak hanya membantu meningkatkan daya tahan 

perangkat keras tetapi juga mengurangi biaya operasional 

dan dampak lingkungan akibat konsumsi energi yang 

berlebihan. 

7.4 Alternatif Hardware untuk performa lebih baik 

Meskipun ESP32-CAM adalah pilihan yang populer 

untuk sistem kendali pintu berbasis IoT karena ukurannya 

yang ringkas dan harga yang terjangkau, perangkat ini 
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memiliki beberapa keterbatasan, terutama dalam hal 

kecepatan pemrosesan, kualitas kamera, dan efisiensi daya. 

Untuk meningkatkan performa sistem secara keseluruhan, 

diperlukan alternatif hardware yang lebih optimal sesuai 

dengan kebutuhan, baik dalam aspek pemrosesan, kualitas 

deteksi wajah, maupun efisiensi daya. Penggunaan ESP32-S3 

atau Raspberry Pi untuk Pemrosesan yang Lebih Cepat dan 

Dukungan AI yang Lebih Baik. ESP32-CAM menggunakan 

prosesor ESP32-D0WD, yang memiliki keterbatasan dalam 

pemrosesan tugas berbasis AI, seperti pengenalan wajah 

secara real-time(Pringsewu et al., 2024). Jika sistem 

memerlukan deteksi wajah yang lebih cepat dan akurat, maka 

ESP32-S3 bisa menjadi alternatif yang lebih baik. 

ESP32-S3 dilengkapi dengan dukungan akselerasi 

AI dan TensorFlow Lite, sehingga lebih optimal untuk tugas-

tugas berbasis machine learning, termasuk pengenalan wajah. 

Selain itu, ESP32-S3 juga memiliki RAM yang lebih besar 

dibandingkan ESP32-CAM, yang memungkinkan 

pemrosesan gambar yang lebih baik tanpa keterbatasan 

memori. 

Jika sistem membutuhkan performa yang jauh lebih 

tinggi, Raspberry Pi dapat menjadi pilihan yang lebih baik. 

Raspberry Pi, terutama model seperti Raspberry Pi 4 atau 

Raspberry Pi Zero 2 W, memiliki prosesor yang lebih kuat 

dan mampu menjalankan model AI yang lebih kompleks 

dengan kecepatan lebih tinggi. Dengan Raspberry Pi, sistem 

dapat menggunakan model deteksi wajah berbasis OpenCV 

atau bahkan TensorFlow untuk meningkatkan akurasi 

pengenalan wajah. Namun, penggunaan Raspberry Pi juga 
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berarti konsumsi daya yang lebih tinggi dibandingkan ESP32, 

sehingga perlu dipertimbangkan aspek daya dan kebutuhan 

operasional. 

a) Kamera dengan Resolusi Lebih Tinggi untuk 

Meningkatkan Akurasi Deteksi Wajah 

ESP32-CAM menggunakan modul kamera OV2640 

dengan resolusi 2 MP, yang cukup untuk tugas dasar tetapi 

kurang optimal untuk pengenalan wajah yang lebih 

presisi, terutama dalam kondisi pencahayaan rendah atau 

sudut pandang yang kurang ideal. Sebagai alternatif, dapat 

digunakan kamera dengan resolusi yang lebih tinggi, 

seperti: 

 

i. OV5640 (5 MP) – Kamera ini memiliki resolusi lebih 

tinggi dan kualitas gambar yang lebih baik 

dibandingkan OV2640, sehingga dapat 

meningkatkan akurasi dalam mendeteksi wajah. 

ii. Kamera Raspberry Pi (HQ Camera atau Camera 

Module V3) – Jika menggunakan Raspberry Pi, 

modul kamera ini bisa memberikan kualitas gambar 

yang jauh lebih tajam dan jangkauan deteksi yang 

lebih baik. Peningkatan kualitas kamera tidak hanya 

meningkatkan akurasi pengenalan wajah tetapi juga 

mengurangi kemungkinan kesalahan dalam 

mendeteksi atau mengidentifikasi pengguna. 

 

iii. Solenoid dengan Konsumsi Daya Lebih Rendah 

untuk Meningkatkan Efisiensi Penggunaan Energi 

Solenoid 9V yang digunakan dalam sistem kendali 

pintu saat ini dapat mengonsumsi daya yang cukup 
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besar, terutama jika tetap aktif dalam waktu lama. 

Oleh karena itu, mengganti solenoid dengan 

alternatif yang lebih hemat daya bisa menjadi solusi 

untuk meningkatkan efisiensi energi sistem. 

Beberapa alternatif solenoid yang lebih efisien 

meliputi: 

 

1. Solenoid latching – Solenoid ini hanya 

membutuhkan arus listrik saat mengubah status 

(buka/tutup) dan tidak perlu terus menerus dialiri 

listrik untuk mempertahankan posisinya, sehingga 

menghemat daya secara signifikan. 

2. Solenoid dengan konsumsi daya rendah – 

Beberapa model solenoid memiliki daya kerja 

yang lebih kecil, seperti 5V atau 6V, yang dapat 

mengurangi konsumsi energi dibandingkan 

solenoid 9V standar. 

3. Penggunaan motor servo atau aktuator linier – 

Alternatif lain adalah mengganti solenoid dengan 

servo motor atau aktuator linier, yang dapat 

memberikan kontrol lebih presisi dan konsumsi 

daya yang lebih rendah dalam kondisi 

tertentu(Dendra et al., 2023). 

Dengan mengadopsi alternatif hardware ini, sistem kendali pintu 

dapat beroperasi dengan performa yang lebih baik, respons lebih 

cepat, akurasi pengenalan wajah yang lebih tinggi, serta efisiensi 

daya yang lebih optimal. Pemilihan komponen yang tepat 

bergantung pada kebutuhan spesifik sistem, seperti tingkat 

keamanan yang diinginkan, anggaran, dan lingkungan 

operasional. 
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BAB VIII 

PENUTUP 

 

8.1 Ringkasan Hasil Proyek 

Sistem kendali keamanan pintu pagar berbasis ESP32-CAM 

dan notifiksi Telegram telah berhasil dikembangkan dengan fitur 

utama berupa pengenalan wajah sebagai metode autentikasi. 

Dengan adanya integrasi ke Telegram, pengguna dapat menerima 

notifikasi secara real-time mengenai aktivitas di depan pintu serta 

mengontrol akses dari jarak jauh. Sistem ini memberikan solusi 

keamanan yang lebih praktis dibandingkan metode konvensional 

seperti kunci mekanis atau kartu akses, yang memiliki risiko 

seperti kehilangan atau duplikasi. 

Dari hasil pengujian, sistem dapat mengenali wajah dengan 

cukup baik dalam kondisi pencahayaan yang optimal serta 

memberikan respon cepat terhadap perintah pengguna. Kamera 

ESP32-CAM mampu menangkap gambar wajah dengan jelas, 

kemudian menganalisisnya menggunakan algoritma yang telah 

diprogram untuk mencocokkan dengan data pengguna yang 

terdaftar. Jika wajah yang terdeteksi cocok dengan database, 

pintu akan terbuka secara otomatis, sementara jika tidak, akses 

akan ditolak dan pengguna akan mendapatkan notifikasi 

peringatan. 

Implementasi teknologi IoT dalam sistem ini memungkinkan 

kontrol akses yang lebih modern dan efisien, karena pengguna 

tidak perlu lagi berada di lokasi untuk mengelola akses pintu. 

Melalui Telegram, pengguna dapat menerima pemberitahuan, 

melihat gambar pengunjung, serta memberikan izin atau menolak 
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akses dari mana saja selama perangkat mereka terhubung ke 

internet. Selain itu, sistem ini dapat meningkatkan keamanan 

karena mencatat setiap aktivitas yang terjadi, sehingga pengguna 

memiliki riwayat akses yang dapat dipantau kapan saja. 

Secara keseluruhan, proyek ini membuktikan bahwa 

teknologi pengenalan wajah yang dikombinasikan dengan IoT 

dapat diterapkan secara efektif untuk meningkatkan keamanan 

akses pintu. Dengan penyempurnaan lebih lanjut, seperti 

peningkatan akurasi pengenalan wajah dan pengamanan data, 

sistem ini berpotensi menjadi solusi keamanan yang lebih cerdas 

dan dapat digunakan dalam berbagai skenario, mulai dari rumah 

pribadi hingga fasilitas umum dengan tingkat keamanan tinggi. 

8.2 Evaluasi kelebihan dan kekurangan sistem 

Sistem ini memiliki beberapa kelebihan yang membuatnya 

lebih unggul dibandingkan metode kontrol akses konvensional. 

Salah satu kelebihan utamanya adalah kemudahan dalam 

penggunaan, di mana pengguna dapat mengontrol akses pintu 

hanya melalui smartphone tanpa perlu membawa kunci fisik. Hal 

ini mengurangi risiko kehilangan kunci atau kesulitan saat harus 

menggandakannya. Dengan menggunakan teknologi pengenalan 

wajah, sistem ini juga menawarkan tingkat keamanan yang lebih 

tinggi dibandingkan metode tradisional seperti kunci mekanis 

atau kartu akses yang rentan terhadap pencurian atau 

penyalahgunaan. 

Selain itu, integrasi dengan aplikasi Telegram memberikan 

fleksibilitas yang lebih baik bagi pengguna dalam memantau 

akses pintu secara real-time. Pengguna tidak hanya dapat 

membuka atau mengunci pintu dari jarak jauh, tetapi juga 

menerima notifikasi langsung ketika ada seseorang yang 
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mencoba mengakses pintu. Hal ini sangat berguna untuk 

meningkatkan keamanan, terutama jika pengguna sedang tidak 

berada di lokasi. Dengan adanya dokumentasi aktivitas yang 

tercatat di Telegram, pengguna juga dapat memeriksa riwayat 

akses kapan saja untuk memastikan tidak ada aktivitas 

mencurigakan yang terjadi(Dila Faza et al., 2023). 

Meskipun memiliki berbagai keunggulan, sistem ini juga 

memiliki beberapa kekurangan yang perlu diperhatikan. Salah satu 

kendala utama adalah ketergantungan pada koneksi internet. 

Sistem ini tidak dapat berfungsi optimal jika jaringan internet 

tidak stabil atau mengalami gangguan. Hal ini dapat menyebabkan 

keterlambatan dalam menerima notifikasi atau bahkan kegagalan 

dalam membuka pintu jika sistem tidak dapat berkomunikasi 

dengan server. Oleh karena itu, penggunaan jaringan internet yang 

andal dan stabil menjadi faktor penting dalam implementasi sistem 

ini. 

Selain itu, akurasi pengenalan wajah dapat menurun dalam 

kondisi pencahayaan yang kurang baik atau jika sudut 

pengambilan gambar tidak ideal. Kamera ESP32-CAM memiliki 

keterbatasan dalam menangkap gambar dengan kualitas tinggi di 

lingkungan dengan pencahayaan rendah, yang dapat memengaruhi 

keberhasilan sistem dalam mengenali wajah pengguna. Oleh 

karena itu, diperlukan optimasi pada algoritma pengenalan wajah 

atau penambahan pencahayaan di sekitar area kamera untuk 

memastikan hasil yang lebih akurat. 

Faktor keamanan data juga menjadi perhatian dalam sistem 

ini. Karena sistem terhubung ke internet, ada potensi risiko 

terhadap serangan siber seperti peretasan atau penyadapan data. 

Jika tidak dilindungi dengan baik, data wajah pengguna bisa saja 
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disalahgunakan oleh pihak yang tidak bertanggung jawab. Oleh 

karena itu, diperlukan langkah-langkah keamanan tambahan, 

seperti enkripsi data yang lebih kuat dan penggunaan sistem 

autentikasi yang lebih aman, untuk memastikan bahwa sistem ini 

tetap dapat beroperasi dengan tingkat keamanan yang tinggi. 

8.3 pengembangan ke depan 

Untuk meningkatkan kinerja sistem, beberapa pengembangan 

dapat dilakukan agar lebih efektif, aman, dan dapat digunakan 

dalam berbagai kondisi. Salah satu perbaikan yang dapat 

diterapkan adalah menambahkan metode autentikasi alternatif, 

seperti sidik jari atau kode PIN, sebagai cadangan jika pengenalan 

wajah mengalami kendala. Dengan adanya metode autentikasi 

ganda (multi-factor authentication), sistem akan menjadi lebih 

fleksibel dan tetap dapat digunakan meskipun fitur pengenalan 

wajah mengalami kesalahan dalam mendeteksi 

pengguna(Zulkarnaen et al., 2024). Hal ini juga dapat 

meningkatkan kenyamanan pengguna yang mungkin mengalami 

kesulitan dalam kondisi pencahayaan rendah atau saat sistem 

gagal mengenali wajah karena perubahan seperti penggunaan 

masker atau aksesoris tertentu. 

Selain itu, penggunaan algoritma kecerdasan buatan (AI) 

yang lebih canggih dapat meningkatkan akurasi dalam mendeteksi 

wajah, bahkan dalam kondisi pencahayaan yang minim atau sudut 

pengambilan gambar yang tidak ideal. AI dapat digunakan untuk 

mempelajari berbagai variasi wajah pengguna, sehingga sistem 

menjadi lebih adaptif dan mampu mengenali wajah dengan lebih 

akurat. Penggunaan model pembelajaran mesin yang lebih 

kompleks juga memungkinkan sistem untuk membedakan antara 

wajah asli dan gambar wajah yang digunakan untuk mencoba 
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mengelabui sistem (spoofing). Dengan demikian, tingkat 

keamanan sistem dapat lebih ditingkatkan dan risiko akses yang 

tidak sah dapat diminimalkan. 

Keamanan data juga menjadi aspek yang sangat penting 

dalam pengembangan sistem ini. Karena sistem ini beroperasi 

dengan teknologi IoT dan terhubung ke internet, maka risiko 

serangan siber harus diantisipasi dengan menerapkan langkah-

langkah keamanan tambahan. Salah satu upaya yang dapat 

dilakukan adalah menerapkan enkripsi data yang lebih kuat, baik 

pada komunikasi antara ESP32-CAM dengan server maupun pada 

penyimpanan data pengguna. Selain itu, penggunaan server lokal 

atau penyimpanan berbasis cloud yang lebih aman dapat menjadi 

solusi untuk menjaga integritas data pengguna, sehingga data 

wajah yang tersimpan tidak mudah diakses oleh pihak yang tidak 

berwenang(Anwari1 et al., 2024). 

Pengembangan dari sisi antarmuka pengguna juga perlu 

diperhatikan agar sistem lebih mudah digunakan oleh berbagai 

kalangan. Antarmuka yang lebih ramah pengguna (user-friendly) 

dapat membantu pengguna dalam mengelola sistem dengan lebih 

nyaman, terutama bagi mereka yang tidak memiliki latar belakang 

teknis. Misalnya, pembuatan aplikasi khusus berbasis Android 

atau iOS yang memiliki tampilan sederhana dan intuitif dapat 

menjadi solusi untuk meningkatkan pengalaman pengguna dalam 

mengoperasikan sistem ini. 

Selain perbaikan pada aspek teknis, uji coba dalam berbagai 

skenario penggunaan juga perlu dilakukan untuk memastikan 

sistem dapat berfungsi dengan baik di lingkungan yang berbeda. 

Pengujian pada berbagai kondisi cuaca, tingkat pencahayaan, serta 

variasi wajah pengguna dapat membantu mengidentifikasi 
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kelemahan yang masih ada dan memberikan solusi yang lebih 

optimal. Dengan pengembangan yang berkelanjutan, sistem ini 

dapat terus disempurnakan agar semakin andal dan dapat 

digunakan secara luas dalam berbagai kebutuhan keamanan akses. 

8.4 Potensi Implementasi dalam skala besar 

Sistem ini memiliki potensi besar untuk diimplementasikan 

dalam berbagai lingkungan, mulai dari skala kecil seperti rumah 

pribadi hingga skala besar seperti kompleks perumahan, 

perkantoran, dan fasilitas umum yang memerlukan kontrol akses 

yang lebih modern dan efisien. Dalam konteks perumahan, sistem 

ini dapat digunakan sebagai solusi keamanan bagi penghuni 

rumah yang ingin meningkatkan kontrol akses tanpa harus 

bergantung pada kunci fisik. Dengan integrasi ke Telegram atau 

aplikasi khusus, penghuni dapat memantau siapa saja yang datang 

dan pergi, serta memberikan akses kepada tamu atau anggota 

keluarga tanpa harus berada di lokasi. 

Pada skala yang lebih luas, sistem ini dapat diterapkan di 

gedung bertingkat atau lingkungan bisnis dengan akses multi-

user, di mana setiap pengguna memiliki hak akses yang berbeda. 

Misalnya, dalam lingkungan perkantoran, sistem dapat diprogram 

untuk memberikan akses hanya kepada karyawan yang terdaftar, 

sementara pengunjung perlu mendapatkan izin terlebih dahulu 

sebelum memasuki area tertentu. Sistem ini juga dapat 

dikombinasikan dengan kartu akses atau metode autentikasi 

lainnya untuk meningkatkan fleksibilitas dan keamanan. Selain 

itu, penerapan di fasilitas umum seperti sekolah, universitas, atau 

rumah sakit juga dapat memberikan manfaat besar dalam 

meningkatkan keamanan dan efisiensi operasional. 
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Integrasi dengan teknologi smart home juga membuka 

peluang untuk meningkatkan fungsionalitas sistem. Dengan 

menghubungkan sistem ini ke perangkat keamanan lain seperti 

kamera CCTV, alarm otomatis, atau sensor gerak, tingkat 

keamanan dapat lebih ditingkatkan(Fahmi Udin Ma et al., 2022). 

Misalnya, jika sistem mendeteksi wajah yang tidak dikenal, maka 

secara otomatis dapat mengaktifkan alarm atau memberi 

peringatan kepada pemilik rumah. Pengguna juga dapat mengatur 

skenario otomatis, seperti menyalakan lampu atau membuka 

pintu garasi saat wajah mereka dikenali oleh sistem. 

Jika dikembangkan lebih lanjut dengan teknologi kecerdasan 

buatan (AI) dan machine learning, sistem ini dapat menjadi solusi 

keamanan yang lebih cerdas, responsif, dan efisien. AI dapat 

digunakan untuk meningkatkan akurasi pengenalan wajah, 

mendeteksi perilaku mencurigakan, atau bahkan mengenali 

ekspresi wajah untuk menentukan apakah seseorang dalam 

kondisi darurat. Dengan penerapan teknologi yang lebih canggih, 

sistem ini tidak hanya akan menjadi alat keamanan, tetapi juga 

bagian dari ekosistem IoT yang lebih luas untuk menciptakan 

lingkungan yang lebih aman dan nyaman bagi penggunanya. 
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Keamanan akses menjadi aspek penting dalam sistem 

otomatisasi modern. Buku ini membahas "Sistem Kendali 

Keamanan Pintu Pagar Berbasis ESP32-CAM dan 

Notifikasi Telegram", sebuah solusi inovatif yang 

menggabungkan teknologi deteksi wajah, kontrol 

wireless, dan notifikasi real-time untuk meningkatkan 

keamanan rumah atau bangunan.  

Dengan pendekatan langsung dan praktis, buku ini 

memandu pembaca dalam perancangan dan perakitan 

perangkat keras menggunakan ESP32-CAM dan 

solenoid, pemrograman ESP32-CAM untuk deteksi 

wajah sebagai kunci akses, serta integrasi dengan 

Telegram yang memungkinkan pemilik menerima 

notifikasi dan mengontrol pintu dari jarak jauh. Selain itu, 

buku ini juga membahas analisis kinerja sistem, 

mencakup kecepatan deteksi, konsumsi daya, dan tingkat 

akurasi. Cocok bagi mahasiswa, pengembang sistem IoT, 

serta siapa pun yang ingin membangun sistem keamanan 

pintar berbasis teknologi terkini, buku ini memberikan 

wawasan mendalam dan panduan langkah demi langkah 

untuk mewujudkan proyek ini secara nyata. 


